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Introduction

Before we begin, let's look at some of the advantages of a database.

Access to data more quickly and easily.
All the data is in a single place; in your database
Able group together data that comes from several sources.
Easy to make Ad hoc searches or analysis. Ex: How many of product X do we have

in stock? Who are top ten customers at the moment? What products is selling best?
Who are my best salespersons? My worst ?

Better follow-up on data.
Better data management.
Better data analysis.
Better decision-taking.
Better able to meet the needs of the clientele.
Automation of certain repetitive tasks.

Why learn how to use a relational database?

This type of database has several advantages compared with a simple database also
called" flat file". It uses much less space because it removes the repetition or the
redundancy of the data. To understand better the advantages of a relational
database management system ( RDBMS), let us use an example of invoices to
compare these two types of database and to show certain basic concepts of a
RDBMS.

Let's look at some of the data you would normally find on an invoice:
Ex: Date, Invoice number, Salesperson ID Number, Product ID, Quantity sold, Unit
price, Product description, Subtotal, Taxes, Total...

Here are some of these data in one simple database.

Invoice No. Customer Product Description Unit price

1001 ABC 415 TRIANGLE 12.75

1002 ABC 416 SQUARE 10.00

1003 XYZ 415 TRIANGLE 12.75
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The idea of a relational database is to distribute the data into many identifiable
distinct databases or tables and then to create connections, common info, links,
relations among each of them. Here is how fields of an invoice could be divided in a
relational database.

Invoice Customer Employee Inventory

Invoice No. Customer ID Employee ID Product ID

Product ID Address Last name Description

Qty sold Postal code Prénom (first name) Unit price

Employee ID Phone no. Social Security No. Available qty

No. Customer Person in charge Hiring date Ordered qty

In the previous tables, the table Customer ID field fetches the data about the
customer in the Customer table. It's useless to rewrite the data of the customer
several times ! The database can fetch the data on the customer thanks to a relation
between these two tables on the Customer ID field. The same thing occurs for the
necessary data for the tables Employee (salesperson) and Inventory by their
common fields Employee ID and Product ID respectively.

Because of the relations between the tables, it's useless to rewrite the redundant or
repetitive data. This preserves more space for other data. To some extent, it also
avoids errors while rewriting the same data like "typos". For the three invoices of the
example, you save space and time by not having to rewrite the data about the
customer ABC nor the description and the unit price of the product 415. And this is
just about three invoices ! Image the savings when you have hundreds and
thousands of invoices per day !

Definition

The use of a database brings also new terms to be understood. Here is the list of the
terms that will be used for all the pages in Access's section.

Field: A necessary data about a person, a thing or an event. Ex: color, size,

model, date, name, Prénom (first name), telephone, addresses,

description, comments etc.

Record: A group fields that describes a person, a thing or an event. Ex: name,

Prénom (first name), date of birth, telephone, number of social security

number,company employee ID, address, telephone, fax, person in

charge, department...
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The field phone number can be used by three different ways. It can be
the phone number of an employee, a person in another department or
another company.

Table: A group of records that have a subject a common. Ex: employees,

inventory, customer, suppliers, vehicles, contacts etc.

Database: A group of tables, queries, forms, reports and programming that

constitutes a complete data system. Ex: management for invoicing,

management for inventory, registration of vehicles, bookings etc.

The definition of a database now takes a larger role than it had previously. It's not
just what we now call a table anymore; a file that contains of the useful data for the
user. It now contains the queries, the forms, the states, the macro and the modules
to develop an "application" or a complete "system" that answers to the specific
needs of the user.

What are the components of Access?

Tables:
Structure of the table, list of fields and the data the user

enters are stored there.

Queries:
Search for data that answers certain criteria determined by

the user.

Form:
Presentation of the data on the screen in a practical way for

the user to view, enter and modify data.

État:
Presentation of the data about paper in a practical way for

the user.

Macro:
Development of routines to automate certain tasks.

Modules:
Programming

Create a database

To help you to understand the creation of a database, this page will demonstrate the
stages to be followed. To avoid repeating the text of this section of the site, you'll be

asked to go and read the text of the other pages on tables and relations. The
exercise will consist in creating a database for the invoicing of a company.

The first stage of the creation of a database is the analysis. It's without a doubt the
most important stage. In fact, it's also true for any application or document that you
create. Think first ! If you pass too quickly on this stage, you'll then lose a lot of time
and efforts to redo what should have been carried out previously.
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Before creating your database, it's necessary that you have a clear idea of what your
needs will be. It's necessary to prepare a detailed analysis of your needs. What are
the data that you'll need? Ex: What data I need on my customers, on my suppliers,
on my inventory, on my staff etc.

A technique, among others, than you can use consists in working from the " top-
down ". Think of the forms and reports that you'll need. Knowing the results that you
need, it's necessary to find what are the necessary fields to reach these results. For
example, it's necessary to know the quantities sold and the unit price before knowing
the total of sales.

You can also use the " bottom-up " technique. From the base, you determine all the
data that are necessary for your queries, forms and reports of your database. You
can use both techniques toinsure that you have all the necessary data.

For the purpose of the exercise, take a moment and write on a sheet of paper with
the fields you can find on an invoice. try to find as many fields as you can.

To avoid cheating, I put the list of the fields that I found at the bottom of this page.

You can compare with my results after having done the exercise. Press this link to
see the list.

The second stage: group together the data into tables.

It's then necessary to group together the fields into entities in a table that have a
common theme. Ex: Will the fields "Discount" or "Terms of payment" go to the table
"Invoice" or with "Customer"? It all depends on your conditions you have to fulfill.

To start things off, I'm going to demonstrate first my technique to group together
fields into tables and to determine the relations between these tables. Later, we will
look at the normalization technique. My technique is a little more simplistic and asks
for a little of experience. The use of the technique of the normalization is, in a way,
more difficult to carry out. But it's infallible when you understand and apply it
correctly. These two ways try to reach the same result: to group together fields in
tables in the most efficient way possible. For starters ... My technique.

The concept is to distribute fields in the biggest number of possible tables. But there
are certain rules that should be followed:

Regroup fields into tables that have something in common: an object, a person or
an event for example.

Fields should not apper twince, unless there fields that help link two different
tables.

No double, or triple, data entry.
No fields that you can determine by using other field in the database. . Ex.: Total =

Qty * Unit price

It's necessary to group the fields into tables. What are the fields can be grouped
together? To help you in this task, base yourselves on elements of your everyday
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life, something concrete. For the invoice, you can find elements that are on the
invoice, the customer, the products and the salesperson. That makes four tables that
will be used: Invoice, Customer, Product, Employee.

Make sure that fields are in the right table. There should be no tables hidden inside
another. Each is distinct.

With the exception of fields in common that are used for "connecting" the tables
together, a field should not be in several tables. Again, let's take for example, the
field Telephone number. Although, in this example, it could be in the Employee and
Customer table, it's not the same thing. One is the number of an employee, the
other of a customer. They have the same name but don't carry the same
information.

Determine the primary keys

A primary key is a field, or a series of fields, that allows to differentiate a recording
of the others. For example, although you can have several invoices with the same
date, the same quantity bought, to the same customer with the same salesperson,
there will not be two invoices with the same invoice number. A primary key is not
compulsory for a table. It does becomes essential when you want to connect two
tables. At least one of the two tables must have a primary key.

Try to determine that field would be suited for a primary key for the Employees
table. Certainly not the field Sex. Unless there is only a man and a woman in the
company. This limits a little the growth of the company! Smoker or not ? Same
thing. There are only two possible values (M or F, Yes or No...). Because one cannot
enter the same value twice in a primary key, these fields are not a good choice.

It's possible to use the field Last name until two persons have the same name.
Then, it's always possible to create a primary key using of two fields: Last name
and Prénom (first name). This key will work correctly until two employees have
the same first and last name. To solve this problem, it's possible to create a primary
key using of the Last name, Prénom (first name) and the date of birth. This
primary key will work correctly until... This can continue for a long time.

After a certain point, you'll see that it's better to have a field named Employee's ID
number or Social security number to distinguish each of the records of the table. But
there are occasions where it's necessary to have a primary key that consists of
several fields. One of these situations will be explained a little farther on this page.

Take a moment to try to determine that fields in the tables would be best suited as

the primary key or be part of the primary key. The explanation to apply the primary
key to one or several fields of the table is on the following Web page on tables.

Determine the relations between tables

Determine the types of relations ( cardinality)

There are three types of relations: 1 to 1 , 1 to Many and Many to Many.
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The image above demonstrates the list of tables with the fields that compose them.
The lines indicates the relations between these tables. A many to many relation, like
between Invoice and Products, requires a compound or intermediary table, with at
least the primary key of both tables to be included. That's the reason for the new
table Transition Fact-Inv.

The normalization and the normal forms.

The advantage of a relational database is to avoid as much as possible the repetition
of data. The normalization serves at separating the list of fields into several tables so
you can have a more efficient database. The normal forms gradually removes some
the problems that you can find in databases. You can use various normal forms (1st ,
2nd , 3rd...) For the moment, we are going only to look at the first three normal
forms.

Before showing how to carry out you the first normal forms by using the list of fields
that one finds in an invoice, here are the rules that the tables in your database
should follow so that you have an efficient database.

The first normal firm is necessary to eliminate the repetitive groups by separating
them in several tables.

The work to be carried out to reach the first normal form is to avoid completely the
repetition in data entry.

But it's also necessary to implement this form to make sure that the user is not
going to enter several times the same data. For example, it would not be efficient to
have a table "Invoice" that would contain fields " Name of the customer " , " Address
of delivery " , " person in charge ". It would not pass in the first normal form. The
reason is that it would be necessary that the user enters for every invoice the same
data that he already has entered in the previous invoices for the same customer.
After all, how many times can you enter the same address? That's not really
efficient! It's for that reason that it's necessary "to cut" the list of the fields that you
need into several tables to have an efficient form for data entry.
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The second normal form helps eliminate partial dependences. Make sure that all the
fields of the table belong to the same primary key. Otherwise, it will be necessary to
split the fields and to create a new table.

The third normal form is eliminate the transitive dependences (the what???) make
sure that there are no tables that are hidden from the others.

Also, tables should not contain calculated fields. For example, a table should not
have the fields "Subtotal", "Total", " GST ", " TVQ ", "VAT" (value added tax in
Europe) or other taxes " because it's possible to calculate them from the data that
are already in tables. For example, it's possible to have the "Subtotal" by multiplying
" Quantities sold " by "Unit price". So, it's useless to take that space for subtotals in
tables.

The third stage is to determine the relations between the various tables. It's
necessary to look that are the possible relations between the entities. To have a
relation, two tables should have at least a field in common. You can connect an
invoice to a customer with the field " Client ID". You can also connect a product to an
invoice by the field " Product ID " etc. You should have to at this moment notice that
certain fields would be better placed in another entity. Make the changes in the
tables if necessary. When you'll have grouped the fields together and determined the
relations, you'll have your base for the creation of tables.

Now that you have the entities (tables) and the fields that compose them, think of
what your forms and your reports should look like. Do the fields that you chose
answer all your needs? Take all the time required for this analysis. It will cost you a
lot more time and effort if you pass too quickly on the creation process and forget
important elements.

Warning !

If you are in the computer lab to create your first database, make sure to save the

file in drive A: of your PC. Do not create your database on the hard drive. Otherwise,

a technician will be obliged to come to help you to move it on to your floppy disk.

Every school semester, a student "loses" his database that he, or she, created on the

hard drive instead of his or her personal floppy disk.

From the File menu, select the New option.

Access will ask you the name that you wish to give to the new database and where
(drive, diskette, folder ...) you want to place it.

For the purpose of this demonstration, call it ACCESS1.MDB.
Press the OK button.

Now you created the database, it remains you still have to create tables, enter the
data, create the queries, forms, reports, macros and the modules for your database.
So, there's still a lot of work to do. But it's a start.
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Repair a database

It can happen that you accidentally removed the floppy disk that contains your
database before having closed it in Access. Or, the floppy disk has a problem that
can wreck a database. This can damage a database. Access offers you a way for
repairing a damaged database. The procedure is made in two stages: repair and
compact the database. The first one isolates the problem and the second removes
the problematic parts from the database.

Open Access but don't open any database.
From the Tools menu, select the Utility option.
Select the Repair database option.
Select the database that needs to be repaired on your hard drive or diskette.

Press the Repair button.

Access will take a few moments to repair your database. If everything works well,
Access will show you a message indicating that the database was repaired
successfully.

Compact a database

The last stage isolated the problem. But it's still in the database. The compact
operation will remove the records, the tables, the queries and the states that you
removed from your database, but also the problem. Although they are not accessible
anymore, they are still in the database file.

Open Access but don't open any database.
From the Tools menu, select the Utility option.
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Select the Compress a database option.
Select the file to compress the hard drive or the diskette.

Press the Compress button.

The operation to compact a database consists in creating a new database with only
the elements that are still useful. Access will ask you for the name of the new
database.

Enter a name for the new database of your choice in the Name of file box.
Press the Enter key or the Save button.
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In spite of this procedure, it's always possible that the database is too damaged to
be repaired. For that reason, as much for Access's databases as for any other
document, that you should have a copy of your documents. Don't forget that with
Access, it's impossible to make a copy while the database is opened. You can copy
the file of the database only after having closed Access.

List of fields

At the beginning of this page, I asked you to determine the list of fields that you
would find on an invoice. Here is the list of fields that I found. There are probably
even more.

Date, Invoice ID Number, Customer's ID number, Customer's address, City, Phone
number, Fax Number, E-mail Address, Address for delivery, Person in charge, Terms
of payment, Number of product, Description of the product, Unit price of the product,
Quantity bought, Total for the item, Subtotal, GST (Goods and Services Tax, sales
tax of 7 % on the total), TVQ (Taxe of vente du Quebec, 7,5 % sales tax of the total
and the GST), Grand total, Discount, Order form, Employee ID number, Name of the
salesperson...

Wow! It's a little more than you might have though. click here to return following
text.
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Access - Tables

Introduction
Create a table
Types of fields
Field proprerties
Insert a mask
Insert un Valide Si
Modifiy a table

 Insert a field
 Move a field
 Delete a field

Place a primairy key

Creating a filter

Activate a filter

Deactivate a filter

Print the table's structure

Export a table

Import a table

Link a table

Introduction

It is in the tables that you find the information of the data base. These tables are
structured. The structure contains the list of fields as well as the properties or the
characteristics of these fields. This page gives you not only the information about the
creation of a table, but also about the addition and the modification of this one.

To do it, the first part of this page consists in the creation of a table to keep certain
information about the employees of a company. You go to see in this way all the
stages for the creation and the management of a table.

At the time of the creation of your tables for your needs, don't especially forget the
phase of analysis. A good analysis in depth of your needs and the data that you need
to reach your expectations can at the end save you time and escalations a lot. This

phase is explained in more details on Access's introduction page.

Before we begin, here are some explanations on the fields of the table Employees.
Every recording of the table should have the name and the Prénom (first name) of
the person. The post is the occupation that the person occupies in the company. For
this example, there are only two types of occupation: the managers and the
salesmen. The field office(desk) indicates the office location. For this company, there
are employees in Montreal and in Quebec. The managers work according to a salary
whereas the salesmen work only on commission. To end, it is necessary to have the
date of hiring of the employee.
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Here is the list of the fields of the table Employees so that the compulsory
characteristics. Besides giving a name to the field, it is necessary to determine it a
type and, in most of the cases, the size. It is necessary to indicate the size of fields
according to the number of characters that you want to keep in these fields.

Name of the field Type of field Size Format

Prénom (first name) Text 15

Name Text 15

Occupation Text 10

Office Text 15

Salary Monetary

Commission Monetary

Hiring Date Abbreviated date

Create a table

This exercise consists in creating a table that contains of the information about the
employees of a company. Before even entering of the information, it is necessary to
give a structure to this table. It is necessary to determine a list of fields as well as
the characteristics of these fields. It is only after this stage that it will be possible to
enter of the information.

Click on the Tables tab .
Press on the New button.
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Access offers you several ways to create a table of data. The mode worksheet shows
you a grid in that you write simply the information that you want to keep. You can
then choose the mode creation to change the options that Access had determined for
you. The mode creation contains all the options to create and personalize the
structure of a table of data. The assistant Banks gives you of the assistant to the
creation of a table by asking you to choose among a list of fields that you will find
mostly in a table. You can also import a table from another base of datum of Access
or even a working sheet of Excel. The last option allows you to make(do) a link for
another table of another data base and to reach its information.

Of the list of choices, select the Creation mode option.

1. Give a name to the field

During the addition of a field in the structure of a table, it is necessary to give it a
name and a type of field. According to the type of field, it is also necessary to
indicate to Access the number of characters that you want to protect in the field. You
can also, in your choice, add a comment to give more information about the contents
of the field.
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The types of fields

Access the choice between several types of field gives you

Text Can contain figures or letters. By default, Access indicates that the

size of the field is 50 characters. You can always modify the size of

the field according to your needs. The maximum is 255 characters.

Memo Useful to register comments. The size of the field is not definite. The

maximum is 65 535 characters.

Numeric Can contain figures only. You can also determine the name of

figures after the decimal according to your needs.

Date/Time Can contain or show dates or even of the hour. Although a date or

one hour is shown, Access keeps these data in the form of figure.

Every figure represents a day. Figure 1 is by January 1, 1900. The

figure 2 by January 2... Access keeps the hour, the minutes and the

seconds in fractions of day. So 0,5 is the equivalent of noon, 0,75 of

the 18 hours(o'clock) etc. It is also easier to make(do) the difference

between two dates.

Monetary It is about a type of numeric field. The size(format) of the field is

already ready to show the sign $.

NuméroAuto Whole numeric field that increases automatically by one (1) in every

new recording that you add to the table. Formerly called meter. It is

ideal for addition of new invoices, commands(orders) or customers.

Yes/No Logical field. Determine if a case applies or not. Ex: smoker, no-

smoking. Access keeps the information under numeric format. 0 =
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false, 1 = really.

Object OLE A link for an object resulting from applications Windows allows to

make(do). It is capable of managing by binding(connecting) or by

implanting in the data base (Object Linking and Embedding).

Hypertext link A hypertext link for another object allows to make(do) or for one of

the services of the internet that allows the URL (Uniform Ressource

Locator) such as FTP, to gopher, and newsgroups.

Assisting list

of choice

This assistant allows you to reach a list of predetermined choice that

is contained in another table or query. This list can be the contents

of one tables, of a query or what you prepared even you.

In the choice of the user, it is also possible to add a description. This is practical
when you return some months later and want to know why you chose to have these
fields in the table. This description is also going to appear in the left lower corner of
the window at the time of the entry or the modification of the data.

The properties of the field

At the bottom of the screen, there are the characteristics or the properties of the
field. Each is practical under the circumstances. The next part explains each of these
properties and when these are practical. You can also fetch more information about
one of the properties below by placing the pointer on this one and by pressing on the
key F1.

Size: Determine the number of character that can be contained in

a field. This property is only valid for the fields of type Text.

The other types of fields already have a predetermined size.

Format: Determine the way that the information will be shown in the

field.

Mask of seizure: Determine the way that the information will have entered the

field.

Legend: Text that will be shown in the worksheet, the forms and the

states in the place of the name of the field.

Value by default: Determine an initial value during the addition of new

records.

Valid yes: Place of the borders or limits on the kind of information that

can have entered a field. For example, few persons would be

ready of working for a negative salary.
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Message if error: View this message if the contents of the field don't respect

the limitations of the valid property yes.

Null Interdit: If active, does not allow to have an empty contents in the

field.

Authorized empty

chain(channel):

Allows to insert spaces " " into a field.

Being indexed: This property is to show the information in increasing order

during the posting. It is also necessary during the creation of

relations with the other tables.

These last properties are those that are available for the fields of type Text. Here are
some available supplementary properties for the other types of fields.

Decimals (Numeric,

monetary):

Determine the number of decimals that will be kept with the

figure.

New Values (

NuméroAuto):

Determine if the next figure will be the answer of the series

( Incrément) or a (at random unpredictable) figure.

To have more information about the properties of fields:
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Place the pointer in the property for that you want more information. Press the F1
key.

Access's assistant will show you the information that it possesses on this property.

Primary key

A primary key is a field, or a series of fields, that helps to differentiate a recording of
all the others of the table. For example, one can use the number of social assurance
to differentiate each from the employees of the company. There is no two that are
identical. One can also use a number of inventory to differentiate each of the
products of the others etc.

A primary key can also consist of several fields. As long as the combination of field
differentiates a recording of the others. For example, one can add a booking knowing
that there will be two persons who are going to appear at the same time with the
same name. If it would be the case, it would be necessary to add another field to the
primary key to differentiate them. Or, one could simply create a field No. of
booking to solve the problem. The use of several fields to compose a primary key is
very rare but possible.

The method to insert the primary key on one or several fields of the table will be
explained a little farther on this page; at the time of the modification of the table.

Secondary key

A secondary key is a field that is connected with the primary key of another table.
For example, the field of the table Charges can be connected with the key No. of
customer of the table Customers.

Save the structure of the table

Having created a table, it is necessary to keep it.

Press the button.
OR

From the File menu, select the Save option.

Access will ask you that is the name of the new table.

Enter the name of your choice. For this exercise, enter the name Employees and
press the OK button.

Access goes possiblement to ask you if you want to add a primary key to your table.
For the moment, this table does not need primary key. It will be added a little farther
on this page.

Press the No button.
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Data entry

Now the structure of the table is defined, it is possible to enter of the useful
information for the user; data. To begin, there are data on the four employees of the
office(desk) of Montreal. The next stage consists in entering these data the table.

Press the button.
OR

From the View menu, select the Data mode option.

Access will show you a grid to enter the data just like this one but without the data.

Enter the following information about the employees of the company.

Prénom (first

name)
Name Occupation Office Salary Commission Hiring

Roger Lepage Manager Montreal 50000
92-01-

01

Denis Lambert Salesman Montreal 43000
92-01-

01

Suzanne
Being

Rémi
Salesman Montreal 65000

93-01-

01

Éric Gendron Salesman Montreal 23000
93-06-

06

Note: The last line of a table or a query always shows one "*" in the grey box to the
left of the line. This is to indicate the end of this one. enter figures without the signs
$. In the laboratory, enter dates size(format) year ( 2 figures), month, day with a
hyphen among each.

Insert a mask of seizure

A mask of seizure is to indicate to Access the way that the information entered a
table. You can force the user to enter the data in a certain way. For example, it is
unthinkable to have letters in a phone number or a social number of assurance. Also,
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a postal code is a series of letters and figures. How to make sure that the data will
have entered in a right way? It is for that reason that there are the masks of seizure.

Access already has some sizes (models) for the data that you will find mostly in a
data base. The next part is to demonstrate how to reach you these models. You will
apply it according to your needs in your own tables.

Place the cursor on the field that you want to add a mask of seizure.
Among the list of properties, click that of the mask of seizure.

At the end of the box, a button with three little dots inside has just appeared.

Press this button.

Access is maybe going to ask you to protect your table before being able to continue.
protect it. If Access asks you also for a primary key, for the needs of the exercise,
don't add it for the moment.

The window with the list of the models has just appeared.

There are several models. Each is for a different occasion. You can use them to enter
a phone number up to a password.

When you will have chosen mask of seizure, press the Next button.

The following window will appear.
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This window shows you the mask of seizure. You can experiment by writing of the
text in the box To try. It is possible to you to change the size(format) of the mask of
seizure better to answer your needs. By placing the cursor in the box Masks of
seizure and by pressing on the key F1, you will have a list of the possibilities for the
size(format) of the mask of seizure. This list is very detailed and should be read
attentively.

When you will have determined the mask of seizure, press the Next button.



Dr. RACHINI Ali – MS-Access – Tables

21 | 1 9 5

Access asks you then how that the information will be stored in the field: with or
without the symbols of the mask of seizure (the brackets, the spaces as well as the
hyphens).

Select and press the Next button.

A last window should appear to indicate you that the creation of the mask of seizure
is ended.

Unless you wanted to change an option by pressing on the Previous button, press
the End button.

Add a mask of seizure

The previous option how showed to use the masks of existing seizures. But, it is also
possible to you to add your own masks of seizures better to answer your needs. The
text that follows shows the stages to be followed to create a new mask of seizure.
The next exercise will create a new mask of seizure for a code of inventory. This
code consists of three letters, a hyphen and four figures.

Enter the mode of mask of seizure by pressing on the button (....)

Press the button located in the left lower corner of the window.

Press the button to return you to the end of the list of the masks of seizures
and be able to add a new of it.

A window will appear of whom(that,what) all the boxes will be empty. It is to you to
enter the name of the mask of seizure, its presentation, if there are reserved spaces.
You can even add an example of the mask of seizure.

For the purpose of the example, enter the text following in the appropriate boxes.
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After you entered the wanted options, press the Close button.

You can add as many masks of seizure as you want.

Insert a Valid if

The property Confirms If allows to put limits or borders in the entered of data. For
example, there are very few persons who like working for a salary or a negative
commission. The exercise consists in demonstrating ValideSi's functioning by using it
not to allow negative values fields Salary and Commission.

Open the Employees table in creation mode.
Place the pointer on the Salary field.

The properties of the field are going to appear in the section of bottom.

Place the pointer in the Valid box Yes.

It is in this box that you put the criteria of validation. You can use various operators
(= >, <, < =, > =, < >, Among and, or, Not...) to create the criterion of validation.
For the exercise, it is necessary to make sure that the value that entered the field is
not negative.

In the Valid If box , enter the following criterion: > = 0.

In the exercise, it is possible that a person earns no salary or no commission
according to the occupation of the employee in the company. The managers earn
only a salary whereas the salesmen earn only a commission on sales. So, it is
possible to have a salary or a commission equal to zero.

The box Message if error is the text that will appear to the screen when the
contents of the field respect the criteria of validation. In that case, if the user enters
a negative figure.

In the box Message if error, enter the following text: An employee of the
company can not have a negative salary. enter a positive figure or a zero.

repeat the operation for the field Commission.

The next time that you will enter or will modify the contents of the records, try to
enter a negative value to see the result.

Modify the table

After a while, you will notice that changes are necessary for a table. It needs new
fields. Or, certain fields need to be modified or simply eliminated.

From the mode worksheet, press the button
OR

From the View menu, select the creation mode option.



Dr. RACHINI Ali – MS-Access – Tables

23 | 1 9 5

OR
From the main menu, select the table and press the Modify button.

For the example, it is necessary to add four new fields: Numéro of poste
(Employee's ID number), status, permanent status and comments. The field
Numéro of poste (Employee's ID number) will be used to differentiate each of
the records. It will be the primary key of the table. Furthermore, the field Numéro of
poste (Employee's ID number) will be inserted at the beginning of the structure of
the table. The field Status will serve for saving the marital status of the employee.
This field will be the Numeric type. It's going to keep the marial status according to a
number: 1 = bachelor(single woman), 2 = married without dependent, 3 = married
with dependent, 4 = divorced, 5 = divorced with family allowance. So, the only valid
rags are 1 and 5. It will be also used during the creation of a form. The field
Permanent will be the type Yes/No. It's going to determine if the person with
receipt its permanent status in the company. The field Comment will be of type
memo. It will be possible to write comments, about the performance of each from
the employees of the company.

Name of the field
Type of

field
Size Format Other

Numéro of poste

(Employee's ID number)
Meter

Prénom (first name) Text 15

Name Text 15

Occupation Text 10

Office Text 15

Salary Monetary

Commission Monetary

Hiring Date
Abbreviated

date

Status Numeric
Whole

length

Valid yes:

Between 1 and 5

Permanent Yes/No

Comments Memo
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Insert a field

Place the pointer on the line that you want to insert a new field at the table. For the
exercise, place the pointer on the first line of the table, that is the line of the
Prénom (first name) field.

From the Edit menu, select the option Insert line.
OR

Press the button.

A new free line will appear. The other lines will be moved downward.

write the name of the field. For the exercise, it is about Numéro of poste
(Employee's ID number).

Select the type of field Text with a lenght of 15 characters.

insert the new fields Status, Hiring and Comments at the end of the table with
their properties that are described in the table above.

Move a field

To change the order of presentation of fields

Click the grey box to the left of the name of the field.
While pressing the left mouse button , move the field upward or to the bottom

according to your needs.

The field will re-fit into the structure of the table between both fields among that the
line that separates it is more thick as soon as you will release the mouse button.

Delete a field

Click the line of the field that you want to delete. Press the Delete button .
OR

From the menu Edit, select the Delete lines option.

Place the primary key

The primary key is a field, or a series of fields, that allows to distinguish each of the
records. Every person in its social number of assurance, a number of customer or
employee. It can consist of letters or figures. One of the things that Access verifies
later is to make sure that there are two records that will have the same information
in the field. For example, two persons can have the same number of social assurance
or two products the same number of products.

Access will not allow the creation of the primary key if two records have the same
information in the chosen field. If you need absolutely that both records have the
same information, it would be necessary to consider another field, or combination of
fields, for the primary key of the table.
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A table is not obliged to have a primary key. It needs however a primary key if the
other tables want to reach the information of this table. For example, the table
Charges its address and the other information could, thanks to the relations
between tables, reach the information of the table Customers to know the name of
the customer. So, to find more quickly the information and to make sure that there
are two customers with the customers' same number, it is necessary that the field
Customer's number of the table Customers is the primary key of this table.

For this exercise, the new field Numéro of poste (Employee's ID number) will be
the primary key of the table.

Place the pointer on the line of the field that will be the primary key of the table.
For the exercise, it is about the field Numéro of poste (Employee's ID number).

Press the button.

The key placed in the box intoxicates to the left of the field Numéro of poste
(Employee's ID number) confirms that the primary key is on this field.

If by mistake, you chose the bad field as the primary key, press the button for
désélectionner the field as the primary key.

Place a primary key on several fields

A primary key can also consist of several fields. There are even occasions where it is
necessary to have a primary key in this way. For this exercise, the primary key will
consist of fields Prénom (first name), Name and Date of hiring.

Click the small grey box to the left of the Prénom (first name) field.
By keeping one owes on the CTRL key, then click the grey boxes to the left of

fields Name and Hiring.

Press the button.

Here is the final result.

The key placed in the grey box confirms that the primary key consists of fields
Prénom (first name), Name and Hiring. It means that it is possible to register
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several times the same value in one of the fields. But it is impossible to register
several times the same values in all the fields that compose the primary key at the
same time. For example, it is impossible to have two persons with the same Prénom
(first name) and name that are hired at the same time.

For the purpose of the next exercises, replace the primary key on the field Numéro
of poste (Employee's ID number).

Adding records

bring the additions to the already created records and add the other records to your
table.

Numéro

of poste

(Employ

ee's ID

number

)

Prén

om

(first

nam

e)

Name
Occupa

tion

Offic

e

Sala

ry

Commis

sion

Hiri

ng

Stat

us

Perma

nent

Comm

ents

1 Roger
Lepag

e
Manager

Montr

eal

500

00

92-

01-

01

2 Yes

2 Denis
Lambe

rt

Salesma

n

Montr

eal
43000

92-

01-

01

1 Yes

3
Suza

nne

Being

Rémi

Salesma

n

Montr

eal
65000

93-

01-

01

1 Yes

4 Éric
Gendr

on

Salesma

n

Montr

eal
23000

93-

06-

06

5 No

5 Roger Dubuc Manager
Queb

ec

430

00

93-

01-

01

1 Yes

6 Elects
Lavigu

eur

Salesma

n

Queb

ec
47000

93-

06-

01

2 Yes

7 Paul
Gendr

on

Salesma

n

Queb

ec
22000 93-

01-
1 No
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06

Sorting the records

At the time of showing the contents of the table in mode sheet of data, the option of
the sorting shows the records in increasing or lessening order according to a field.

In the sheet of data mode, you will find in the toolbar the following buttons:

. These

Place the cursor in the column that you want to show in increasing or lessening
order.

Press one of the buttons to show the table according to this field in the order that
you want.

All the records will be shown according to the order for that you asked on the field
where is the pointer at this moment.

The filter

The option of the filter allows only to show a part of the records: the one that
answers the criteria that you determined previously. This is very advantageous when
the user wants to find quickly some records among a lot of data.

From the sheet of data mode, you will find buttons to create, activate and

deactivate the filter on a table or a query: .

Creating a filter

Determine the criteria of selection. You can choose only to show a part of the
records; those that answer certain criteria.

From the mode worksheet, press the button.

The list of the fields of the table will appear the one next to another.

To remove the previous filters, press the button.

It remains only to put the criteria only to show the records that answer these
conditions. The exercise consists of showing only the salesmen of the region of
Quebec. So, will be needed two criteria: the one for the Occupation field and the
other one for the Office field.

Place the pointer in the box Occupation.
Press the triangle pointing down at the end of the box.
From the list, select the salesman occupation.
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Place the pointer in the Office box.
Select Quebec from the list.

The list of choices makes easy to find the information. It only shows what is
contained in the field. But, it is also possible to create its own criteria. For example,
it is possible to know that earns a salary superior to 45 000 $ by putting the
operation > 45000 below the Salary field.

It is also possible to combine criteria. In this exercise, two criteria are combined.
Occupation equals to salesman AND Office equals in Quebec.

Activate a filter

To activate the filter, press the button.
OR

From the Filter menu, select the Apply the filter option.

Access will show you the records that answer the criteria that you chose.

Deactivate a filter

Press the button.
OR

From the Record menu, select the option View all the records.

Print the structure of a table

From the Tools menu, select the analyzes option.
Select the documentation option.

The following window will appear.
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Select one or several tables the structure of that you want to print.
Press the Options... button.

The following window will appear.

Select the options that you need.
Press the OK button.

Once having returned to the window of documentation, press the OK button.

Access will generate the state for that you asked. You can see it in the screen or
print it:
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By pressing on the button.
OR

From the File menu, select the option Print.
OR

Press the CTRL and P keys.

Export a table

Access gives you the possibility of exporting the data of tables. These can be
exported towards other data bases or in the size(format) of the other applications
such as Excel or Word. You can in this way take advantage of the possibilities of
these for calculations, analyses or mailing for example. It's to note however that it's

better to export from the queries if you need only a part of the records and not the
whole.

From the main menu, select the Tables tab .
Click on the table that you want to export.
From the File menu, select the Export Record option.

Select the To an external file or a data base option.
Press the OK button.
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Select the name of your choice.
Select the type of file format that answers your needs.
Press the Export button.

Access will create a new document with the data of tables in the size(format) that
you chose.

Import a table

Importer's option allows you to go look for data resulting from the other data bases
or from the other applications and to add them to your data base. The next exercise
consists in importing data from a file Excel. If you have not already made it, protect

the file demodb.xls from the page of the demonstration files on a floppy disk.
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From the main menu, select the Tables tab .
Click on the table that you want to export.
From the File menu, select the External Data and Import .

The next part presumes that you have to protect the file demodb.xls on a floppy
disk.

Of the available list of the drives box, select Floppy disk 3 ½ ( A ).
Of the list of the Type menu of file, select the Microsoft Excel option.
Among the list of files on the floppy disk, select the demodb file.
Press the button Import.

OR
Double-click on the demodb.xls file.
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Access needs to know from the worksheet of Excel about that you will find the data
to be imported. For the exercise, these data on the sheet of work named Sheet1.
There is no other information about this sheet other than the data to be imported.
Otherwise, it would have been necessary to give a name to the block of cells
containing the data to be imported. The assistant of import calls it the option " View
the named(appointed) beaches ".

Select the View the worksheets option.
Select the worksheet named Sheet1.
Press the Next button.
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Access asks you if the data of the first line of the working sheet are the names of the
fields of the table to matter. In that case, it is true that the data of the first line are
the names of fields.

Click on the option First line contains headings columns.
Press the Next button.
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Access asks you if you want to create a new table to store these data and add them
to a table that already exists. For the exercise, the data will be kept in a new table.

Select the option In a new table.
Press the Next button.
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Access asks you now for more information about each of the fields, or columns, the
data to matter. To change the properties of each of the fields, it is enough to click
the grey box containing the name of the field. You can then change some properties
such as the name, the indexation and if you want to import the field or not.

If the first line of the data to be imported was not that with the name of fields, you
can change it now by entering the name of your choice the box Name of the field.
Even if you answered yes the question two windows previously, you can again
change the name better to answer your needs.

Access asks you also if you want to index the field. Choices are not, yes with
doubloon and yes without doubloon. This helps to sort out recording and so
necessary during the relations between tables. It accelerates the access to the data
in the connected tables. place a sorting only on the necessary fields for your needs.
You slow down the presentation of the data when you place the sorting on several
fields of the table.

A last option gives you importer's choice only the fields that you need. It is still
possible to you to exclude a field of the import. It is enough to choose the name of
the field and to tick the box not to import the field.
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Access asks you then for that name you go to look to the table that you import. This
implies that you don't import the data in a table that already exists.

You have also the possibility of activating the assistant of analysis of structure. It
analyzes the data and looks for halvings information. He asks you then if he can cut
the data in several tables to have the most optimal possible structure of tables. For
the purpose of the exercise, don't activate this option. You can also have of the
supplementary assistant when the assistant in ended his work.

Access will confirm you the import of the data according to the choices for that you
asked.

Press the OK button.
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Here is the result of the import if you open the table Employee 2.

Linking a table

To link a table to the data base the advantage gives you to reach data that are
outside of this one without enlarging it for all that. You can also add or remove data
of the outside table. The disadvantage is that you can not change the structure of
this table. The next exercise consists in binding(connecting) the same table as you
mattered in the previous exercise. Some of the stages to be followed to link a data
base external look like those of the import.

From the File menu, select the options external data and Link.
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The next part presumes that you have to protect the file demodb.xls on a floppy
disk.

Of the available list of the readers of the Drive, select Floppy disk 3½ ( A ).
Of the list of the Type menu of file, select the option Microsoft Excel.
Among the list of files on the floppy disk, select the demodb file.
Press the Paste button.

OR
Double-click on the demodb.xls file.



Dr. RACHINI Ali – MS-Access – Tables

40 | 1 9 5

Select the option View the worksheet.
Select the worksheet named Sheet1.
Press the Next button.
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Access asks you if the data of the first line of the working sheet are the names of the
fields of the table to matter. In that case, it is true that the data of the first line are
the names of fields.

Click on the option First line contains headings columns.
Press the Next button.
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To end, Access asks you that is the name that you want to give to the attached
table.

For the purpose of the exercise, write in the Name of the attached table box:
Employees 3.

Press the End button.

Access confirms you that the data of the working sheet Sheet1 of the file demodb.xls
are now accessible from your data base.
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To differentiate the tables of the data base of those that are attached, Access places
an arrow in front of the attached table. Because the data result from the Excel
spreadsheet, the icon of the application appears also.
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Access - Queries

Introduction
Steps to make a query
Modify a query

 Insert a column
 Delete a column
 Move a column

Types of queries
Exporting data

Introduction

One of the most powerful elements of a data base is the capacity to make a search
on a mass of data stored in the data base. It is then possible to make analyses and
to take out of it trends. For example, you don't need to see all the list of the
customers if you need only the phone number of one of them. There are also queries
for certain queries of action such as the update and the deletion of data.

The next section consists in learning the procedure on creating a query by creating
one that will give information about the employees. It is first required to have

created the table "employee" of the page of creation of tables.

If you have no time to create the table, you can copy the data base demoacc1.mdb
(for Access 97) or demoa2k1.mdb (for Access on 2000) containing the table
"Employees" and to begin at once the creation of the queries. These files are on the

page of the demonstrations files that contains all the files used during my

demonstrations and the exercises of this site. click here to return you on this page
then to return. Later, there are explanations for the possible options of a query. The
following Web page consists of exercises to look more and more in depth at the
possibilities of the queries.

Steps to make an Access query

1. Choose one or several tables or queries
2. Choose the type of query
3. Choose one or several required fields
4. Determine if fields need to be sorted out
5. Hide fields from the need
6. Determine the criteria of selection
7. Execute the query
8. Specialized options: grouping, expression generator
9. Connect tables

The next stage consists in creating a query. It is a question of showing the Prénom
(first name) and the name from all the employees whose Prénom (first name) is
Roger.
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Click on the queries tab .
Press the New button.

1. Choose one or several tables and the required queries.

Access offers you several ways to create a query: by using one of the assistants that
Access offers you or by building it from the beginning to the end in creation mode.

The Creation mode is the one that allows you all the options to create a query.
However, there is no assistant to help you. It is partially for that reason that this
page exists; to demonstrate the full potential of the queries.

The simple query assistant asks you for the list of the fields that you want to see
and shows the result. There are no criteria of selection. It shows only the fields you
asked for all the records.

The crosstab query assistant asks you for some questions to create a crossed
image. You can easily know the number, the sum, the average and the other
operations of a field with regard to another. For example, you can know the number
from employees that works in the company by office location and by occupation. Or,
that types of products buy the various customers of the company. It can become a
tool of analysis powerful.

The find doubles query assistant is also very interesting when you have difficulties
creating relations between tables. One of the reasons so that Access refuses to
create a relation between tables is that there is an illegal doubloon in one of the
tables. This query would allow you to know that recording has a contents of a field in
double to allow you to correct the situation.

The assistant query of not correspondence is also useful for the relations between
tables. To what is of use a relation if there is no equivalent datum in the other table?
This query allows to find the records that have no equivalent, or value in common, in
the other connected table. This allows to make sure that all the records are
connected with the information of another table.

For the example, select the Creation mode option.
Press the OK button.
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You can create a query from a table or even from another query. It is even possible
to have a query that consists of fields resulting from several tables or from queries.
Access will ask you of the list of tables and queries to choose who or that one you
want to add to your new query. select, one at the same moment, tables and queries
and press the button add. When you will have selected the table, the query or a
combination of both that you need, press the Close button.

Select the Employees table.
Press the Add button.

Because there are the other tables or the queries to be chosen, press the Close
button.

It is possible to create a query from several tables or from queries or a combination
of both. If, for a reason or the other one, you forgot a table or a query, you can add

it in creation mode by pressing on the button. It will then be required to repeat
the operation above.

For training purposes, the next queries will be all consisted from the Employees
table.

You are now in the screen for the creation of query. The part of the height contains
tables and queries for that you asked previously. The part of bottom is the one that
is the most important. It is there that you decide on fields that you need as well as
options that you want.
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The first line serves to select the fields that you need for your query. The second line
is to determine the order of view of the data. The third line is to determine if the field
should be shown or not. For certain conditions, it's better don't show a field. The
fourth line and the following lines serve for determining the criteria to show a
recording.

2. Choose the type of query

Access offers you six kinds of queries. Each is specialized for a certain kind of query
or operation.

Request query: View the records that answer the wanted criteria. It is the type
that you go to use mostly. It shows only the records that answer the selected
criteria.

Crostab query : View a image of synthesis according to the wanted fields.

New query: Creating a new table with the fields you asked according to the
wanted criteria.

Updated query: Update of the records according to the wanted criteria.

Add query: Add records of another table according to the wanted criteria.

Deletion query: Eliminate records according to the wanted criteria. It is possible
to erase at the same time a group of records that answer the wanted criteria.

For the moment, it is about a query of type selection. It is the one that you use to
carry out searches in a data base. For the exercises number 1 until 21, it is the
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query of type selection that will be used. The following exercises use another type of
queries.

3. Choose one or several required fields

Among tables and the queries that you chose, you should choose the fields that you
need for your new query. It means that you are not obliged to use all the fields; only
those necessities for the query. So, the character "*" located at the beginning of
every table that meets itself in a query indicates that you can add all the fields of
this one in the query in the order that they are at present in the table. This applies
also to the other queries that you can add to your query.

There are three ways to choose a field:

1. Double-click on the field
2. Choose from the list
3. "Drag" a field and insert it in the right place

1. Double-click on the field

Place the pointer over the field that you need.
Double-click by using the left mouse button.

The selected field will be added at the end of the list of fields already selected.

Repeat the operation until you have all the fields required for the query.

2. Choose from the list

Place the pointer in the white cell next to the word Field:.
Click in the cell.
Click on then the black arrow pointing downward the right-hand side of the cell.
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From the list of fields, select the field that you need.
Repeat the action with the cell to the right-hand side until you chose all the

required fields to end your new query.

3. "Drag" a field and insert it in the right place

From the list of tables and queries that you selected, place the pointer on one of
the fields that you want in your new query.

Keep your finger on the left mouse button.

A small white box will appear. This is to indicate that you are "holding" the field of
your choice. It remains only to put it in the zone of the criteria.

While pressing the left mouse button, move the pointer on the line where you want
to insert the field.

This last method is very practical to insert a field between two others. Once chosen,
these fields will be shown in the same order as you chose them from left to right. It
is also possible to move fields in the query.

Place the pointer on the small grey box above the name of the field.
Click on this box.
Keep your finger on the left mouse button.
Move the mouse towards the left-hand or the right-hand side until the selected field

is in its new location.
Release the mouse button.

For the creation of your first query, use the technique that you prefer to put on the
line of fields the Prénom (first name) followed by the field name.
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4. Determine if fields need to be sorted out

When you chose the required fields to complete your new query, you should
determine if these fields need to be shown in a definite order. Do you want the list of
the customers in alphabetical order, in order according to their figure of
affair(business) with your company, according to their geographic place or a
combination of these orders?

Below every name of the field is the option to activate the sorting on this one. You
can decide not to activate it, the sorting or the resources in increasing or lessening
order.

Click in the box of the sortings.
Press the button with the triangle pointing down.
From the list, you can select the type of sorting that you want (ascending,

descending, none).

The priority of the sortings.

It is however required to pay attention. The field sorted out most to the left in the
priority on the others whom is for its right-hand side. So, if fields Prénom (first
name) and name are sorted out, it will be first in order of Prénom (first name)
followed by the name. Ex:

Alain Lacasse

Alain Lemire

Being

Josée

Lacasse .

For the creation of your first query, it is useless to sort out the shown fields.

5. Hide fields from the need

Normally, all the fields that you select will be shown. It happens by moments
however when you need a field for the query but when you don't want to show this
one. For example, you want the Prénom (first name) and name of the persons
gaining(winning) an income superior to 50 000 $ but you don't want to show this
amount.

To hide a field of the view
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Click on the square of view below the option of the sorting.

One "X" in the box indicates that the field will be shown during the presentation of
the records.

For the creation of your first query, it is useless to hide fields.

6. Determine the criteria of selection

Select fields and having placed in the order of your choice, having sorted out on
certain fields, having decided to show or not certain fields, it is required to determine
that are the criteria of selection. If you write no criterion, all the records are going to
appear.

The criteria serve for filtering the records only to show those that you need. For that
purpose, Access offers you several operators for various situations. Here is the list so
that a short description of each.

The operators

= <,>, <=>,

=

Unless another operator is chosen, the criterion is always

equal to the contents of the criterion.

? *
These operators replace a character (?) or a series of

characters (*).

And
It is possible to combine criteria to limit the number of

records that answer the criteria.

Or
It is possible to combine criteria to have most possible

records.

Among and
View the records that are among such and such criteria.

These are including.

Not or <> View all the records EXCEPT those that answer the criteria.

Is null
View the records of that the contents of a certain field are

empty.

Calculated

field

It is possible to create calculated fields that give the result of

a formula that uses the contents of the fields of the

recording. Ex: Total: [Quantity] * [ Prix_Unitaire]
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Operations

Allow to have the sum, the average, the number so the other

mathematical operations on the records that answer the

wanted criteria.

Generator of

expression

Allow to use at most the queries. Use the functions

integrated into Access.

The operators, the operations as well as the expression generators are explained

besides details in the exercises of the next Web page.

For the example, write roger for the criterion under the field "Prénom (first
name)".

7. Execute the query

Press the button.
OR

From the View menu, select the Worksheet option.

The records that answer the criteria will be shown.

To return then to the mode creation, press the button.
OR

From the View menu, select the Creation option.

8. Specialized options: the functions, the expression generator and the operations

Access offers you much more to create complex queries. It offers you a long series of
functions that you can use in the queries, the forms or the states. To help you to use
these functions, Access offers you the expression generators that gives you access to
all the available resources from the software. That it is, fields, tables, queries, forms,
states, macro, modules or integrated functions, they are all available from the
expression generators. To end, it is also possible to group together the records to
make operations such as the sum on a field, to count, to find the average the others.

The functions

Besides the calculated fields, Access possesses functions predetermined to help you
to realize queries and more complex analyses. There are 176 functions of available
that are grouped together(included) in 16 categories. Here is the list of the
categories and the number of functions in each of the categories.

Name of it

Category

Number of

Functions(offices)
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Table 2

Conversion 31

Data base 13

Date/Time 23

DDE 6

Regroup.

Domain

10

Management

of error

4

Financial 13

General 10

Input-output 14

Inspection 5

Mathematics 12

Messages 3

Prog progress 3

Grouping SQL 9

Text 28

There is a function for almost all the occasions. It is enough to press the button
to show the expression generator. From this window, you have access to all the
resources available on Access. To see the list of the functions:
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Double-click on the Functions folder located in the first column of the window.
Click on the Integrated functions folder.

The contents of the second and the third column are going to fill up. The second
column contains the list of the categories of functions. The third column contains the
list of the available functions.

To have more information about one of the functions:

Click on the function that interests you.
Press the Help button.

A description of the function will appear in a window.

The operations

Besides examining with criteria or functions integrated by Access, it is also possible
to group together fields to make(do) operations such as the sum, the numeric
average of fields. Among the other operations, it is also possible to count the number
of records that answer certain criteria.

To reach the operations, press the button.
OR

From the View menu, select the Operations option.

Here is the list of the operations and it that you can carry out by using them.

Name of the

operations

Description
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Group Group together the values of a field.

Sum Find the sum a grouping of records. Only for a field of numeric

or monetary type.

Average Find the average of a grouping of records. Only for a field of

numeric or monetary type.

Min Find the smallest value for the field.

Max Find the biggest value for a field.

Count Count the number of records that answer the wanted criteria.

EcartType Find the standard deviation of a grouping of records. Only for a

field of numeric or monetary type.

The Var Find the variance of a grouping of records. Only for a field of

numeric or monetary type.

First Find the first recording registered in the table that answers the

wanted criteria.

Last Find the last recording registered in the table that answers the

wanted criteria.

Expression Enter the own Formulas or fields calculations for a grouping.

Where Enter criteria without that they are considered for the grouping.

Not all the operations apply to all type of fields. For example, it is unthinkable to
make(do) an average on a field of type Text. Here is a list of the operations and on
that type of fields they can apply.

Operations Text Memo Numeric

Date/Time

Monetary

NuméroAuto

Yes/No

OLE

Sum X

Average X

Min X X
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Max X X

Count X X X X

Écartype X

The Var X

The first one X X X X

The last one X X X X

9. Connect tables.

If your query requires fields that you will find on several fields, you should connect
them on fields in common. It's as possible as you need the other tables to create
links "indirect" between two tables. For example, in the structure of the relations

between the tables that compose an invoice that one sees on the page on the
relations, one notices that there are no direct relations between the table
Customers and that of the inventory of the company.

But there is a relation among Customers and Facture. It there also another relation
among Facture and Transition Fact-Inv and a last one between Transition Fact-
Inv and Inventory. Although there is no "direct" relation among Customers and
Inventory, it is always possible "to connect" them by using the other tables such as
Invoice and Transition Fact-Inv.

Modify a query

After your first outline of the result of the query, it is possible that you want to
modify one or several elements of the query. Some possible reasons are that you
had no expected result or that it misses or that there are too many fields in the



Dr. RACHINI Ali – MS-Access – Queries

57 | 1 9 5

query. So you maybe want to change the order of presentation of fields in the query.
The next part consists in seeing how inserting a new column between fields, deleting
a field of the list and how to move a field in the order of fields shown in the query.

Insert a column

It is possible to insert to insert a column between two fields into the list of the fields
of the query. It is advantageous when you want to insert a field calculated between
two fields that are in the query.

Click on the column placed in the right-hand side of the column that you want to
add.

From the Insert menu, select the Columns option.

Delete a column

You don't need any more a field for a query. It is easy to remove it by following the
following instructions.

Click on the column to be deleted.
From the Edit menu, select the Delete column option.

Move a column

It is also always possible to change the order of presentations of fields in the query.
Before we beginthe operation, take note that it is the point of the arrow that is used
to select the column of the field and to move it.

Click on the small grey box over the name of the field to be moved.

The column completely should be selected.

Place the pointer over of the grey box of the field to be moved.
While pressing the left mouse button, move the field towards the left or to the

right according to your needs.

The field will re-fit into the query in the place where there is a vertical bar between
fields as soon as you will release the left mouse button.

Export the data

As for tables, Access can export the result of a query towards other applications. This
option is more advantageous than for tables because you can ask for the records
that answer your needs. The export allows you to take advantage of opportunities
that offer the other applications.
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Before being able to export the data, it is first required to register(record) the query
in the data base Access.

From the File menu, select the Save option.

Enter the name of your choice.
Press the OK button.

When the query is recorded, it is then possible to export the result to another file
format.

After you are satisfied with results of the query, select of the File menu the Save
as option.

Access a choice offers you: to save the result in a file or as a query in the data base.

Select, the Save as a file or in the database as option.
Press the OK button.
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In the Name of the file box, enter the name of your choice.
From the list of the Type of file, select the file format that answers your needs.
Press the Export button.

Access will create a file in the chosen format. You can then use it to answer your
requirements.
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For this exercise, select the option single Colunm.
Press the Next button.

The next window asks you that is the thorough image of your form. You can
decide not to put a bottom of form by selecting the Standard option.

For this exercise, select the option Twilight.
Press the Next button.
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The last window asks you first for the title of the form.

Change the title to "Liste des employés".

Access will asks for to you what you want to do. You can see the form or modify
the form at once.

For this exercise, select the option Open the form to show or enter
information.

Press the Finish button.

Here is a preview of the form once completed.
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Enter of the data

It's now possible for you to add or to modify the records of the table as you have
it sheet of data during the creation of the table can be made in mode. However,
the presentation of the data is more understandable for a new user than by using
the data sheet mode.

Movement in the form

To move in the form, use the following the keys:

Use the Tab and Shift Tab keys to move you in the next field or the previous
field.

Use the keys PageUp and PageDown to move you from the previous or next
record.

You can also use the navigation bar located in the left lower corner of the
window to move you from a record to another or in the first and last record of the
table.

Use arrows towards the left or to the right to pass in the previous or following
record.

Use arrows with a vertical bar to return you to the first one or to the last record
of the table or the query.

Use the arrow with the star (*) to add a record to the table or to the query.
place the cursor in the white box and write the number of the record that you

want to reach follow-up of the Enter key.

To add a record to the table, go to the last record and press the key PageDown.
An empty record will appear. Then, enter the news given to your choice.
OR

From the toolbar, press the button .

Modify a record

It's very easy to modify the contents of a field if this one is not "locked".

Use the the keys of the keyboard or the navigation bar to return you to the
record that you want to modify.

Place the cursor in the field on that you want to bring modifications.
Change the contents of the field your choice.

Delete a record

Use the the keys of the keyboard or the navigation bar to return you to the
record that you want to modify.

From the Edit menu, select the option Delete the record.
OR

From the toolbar, press the button.
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Look for a record

Access allows you to find quickly a record thanks to a query on the contents one
of the fields of the record.

Place the cursor in the field on that you go to carry out the query.
From the Edit menu, select the option Look for.

OR
Press the keys Ctrl and F.

OR

From the toolbar, press the button.

Enter the value, the date or the name that you are looking for.
Press the Search button.

Personalize a form

Enter creation mode by pressing on the button.

You can change, add and delete objects in your form. Access calls every object of
your form a "control"; whether it's for text, a field or any other object on the
form.

Delete a field

It's always possible to delete a control (object) of the form. It can be a title, a
line, a box or another element of the form; including fields. The exercise that
follows consists in removing the field Poste of the form. The following exercise will
put it back in the form.

Select the field to be deleted. For this exercise, select the field Poste.
Press the Delete key .

OR
From the Edit menu, select the Delete option.

Add a field

The previous exercise consisted in removing a field Poste of the form. It's always
possible to you to add or to put back a field that was on the base of the form.
This exercise consists in putting back(handing) the field posts that had been
removed in the form from the place where it was placed.

Press the button.
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The list of the fields of the table or the query at the source of the form will
appear.

From the list of fields, click the wished field. For this exercise, select the field
Poste.

Press and hold the left mouse button and move the field in the place wished in
the form. For this exercise, replace the field Poste in the original place.

Release the mouse button.

It's enough to pay attention to the order of presentation of fields. This option is

covered farther on this page; see order of tabulation.

Move a control (object)

Make sure before having pressed on the button .
Click on the control to be moved.
Place the cursor on the border of the object. The cursor should be transformed

into a small hand.
Press and hold the left mouse button and move the control towards your

choice.

If you had chosen a zone of text (field) or a title, the associated element (field or
title) is also going to move. Only to move one or the other one:

Make sure before having pressed on the button .
Click on the control to be moved.
Place the cursor on the big black square located in the upper left corner of the

control. The cursor should be transformed into a small hand with the index on the
square.

Press and hold the left mouse button and move the control towards your
choice.

In this last case, only the title or the zone of chosen text will move. In this way,
it's possible for example to put the field below the title.

Move a series of controls (objects)

To move several elements at the same moment, it's first necessary to select
them: with a block by using the mouse or with a combination of mouse clicks and
the Shift key.

With a block of mouse:
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Make sure before having pressed on the button .
Press and hold the left mouse button and move there to surround all the

elements that you want to select.

This technique is practical if elements are close one to another and than there are
no controls that should not be moved from these. To be more selective in your
choices of controls, use the following technique.

Make sure before having pressed on the button .
While pressing on the Shift key, click the controls to be moved.

When elements are chosen, use the technique explained above to move a series
of controls instead of the only one.

Change the presentation of a control (object), change colors.

From the second toolbar, it's possible to change the presentation of the text and

the fields. The following part of the toolbar allows to
change respectively the thorough color, to change the color of the text, to change
the color of the outline, to change the type of outline and to put an effect of relief
in the controls (objects) located on the form.

Change the size of a control (object).

Any time, it's possible to you to modify the size

The toolbar

Press the button to show the toolbar.

The toolbar offers you the access to several controls that you can add to

your form. The next part explains each of these tools and gives an

example of the functioning of each in a form.

select a control

While pressing on the button , it's possible to you to select one or several
controls (objects) to move them then or change one of their properties.
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Activate the assistants

This option allows you to activate or not the assistants for the various controls
of the toolbar. leave the "active" assistants. This will help you during the addition
of certain controls in your form.

Add a "title" or a free text.

So formerly being called labels, they serve for describing fields or for adding of
the supplementary data about the form. A title appears every time you add a field
to the form. To use it:

Press the button .
Click on the form where you want to place the title.
Write the text of your choice.

Add a " zone of text " or an independent field

As for the queries, it's possible to add fields calculated from the other data in a
form or a report. So, you can carry out calculations directly in the form with a
zone of text (i.e. field). For example, the total of an invoice would look like this:
= [ SousTotalProduits] + [ SousTotalServices] + [Taxes]. The only difference
enters a zone of text containing a field of a calculated field is that it's necessary
to put the character "=" at the beginning of the formula.

The next part consists in adding a calculated field that calculates the total of
incomes ( salaire+commission ) from employees. The exercise consists in adding
a zone of text to the form to determine the income (salary and commission) from
the employee shown in the screen.

Press the button to add a zone of text.
Click in the place where you want the independent field.

The zone of text and the title are going to appear.

Place the cursor inside the box of zone of text.
Enter the following formula: = [salary] + [commission]).

Show the form in Form mode by pressing on the button .

If the returned field shows *Nom? There is an error in the formula. watch to
return to the creation mode and to verify the formula.

enter a number the box salary or commission and press the Enter key.
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As soon as you have, press the Enter key, or move the cursor in another field,
Returned independent field that you have just created updated with the new total
of the sum fields Salary and Commission.

You can create your own Formulas to calculate almost anything. You can calculate
the GST and the TVQ on an invoice, the commission of a salesman on an invoice
or use the functions of Access for the other calculations. In fact, you should use a
field calculated in a query, a form or a report in every occasion that you have.

Add a group of options

A group of options allows you, as for the zone of modifiable list and the zone of
list, to choose among a predetermined list. One of the differences between a
group of options and is both others that all the options appear to the screen. For
both others, it's necessary to press a button in the right-hand side of the box to
see the other possibilities. Another difference is that you should write the
description, called a label in Access's jargon, instead of choosing among a list that
meets itself in a table or a query. The last difference is that it's necessary to
determine the value that will be kept in the field for each of the labels that you
wrote.

The exercise consists in creating a group of options that serves for determining
the social status of the employee. The value that will be chosen will be kept in the
field Status of the Employees table.

Press the button .
Click on the form in the place where you want to put a group of options.

In the first window, the assistant of group of options will ask you for the list of
labels, or descriptions, for the choices that you want to offer to the user of the
form.

Write then the list of the possibilities. For this exercise, write the same labels, or
descriptions, as those shown in the window above.

Press the Next button.
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The assistant for the group of options asks you then if one of the values should
be the value by default. What means that there would be a predetermined value.
If no other value is chosen, it's the one that will be the value of the field.

For this exercise, select the option: " No, I don't want to define of value by
default. "

Press the Next button.

Having entered labels, it's necessary to give a value to each of these. By default,
Access shows a number next to each of these labels. It's also possible to you to
put of the text instead of figures. This window allows you to modify these values
to those of your choice.

For this exercise, leave the values to those shown initially in the window.
Press the Next button.
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The assistant asks you then that to make with the selected value. It offers to
save it in an independent field (to save the value for a later user) or to place this
value in a field of a table.

For this exercise, select the option " Store the value in this field: " and select
the field Status.

Press the Next button.

The assistant asks you then of the data about the style of presentation of the
group of options that you prefer. It offers you the choice for the presentation of
labels (descriptions) and of the border that surrounds the group. The left part of
the window offers you a preview of the group of options with your choices of
options.

For this exercise, select the option " Compartment of option " for the
presentation of labels.

Select the option "Spread out" for the choice of the border.
Press the Next button.



Dr. RACHINI Ali – MS-Access – Forms

114 | 1 9 5

The last element that the assistant needs to end the creation of the group is the
title for the group of options. This title will appear at the top of the group of
options. For this exercise:

Write the text following in the box: social Status.
Press the Finish button.

Access will take a moment to generate the group of options with the options that
you chose. Here is the result of the exercise.

With a group of options, it's only possible to choose one of the choices offered in
the box at the same moment. How in this example, it's impossible to be
unmarried and married at the same time!
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Button falls

over

The button falls over, as for the button of option and the button

hook are used for the fields of type Yes/No. It's necessary to press

the button to say "yes" or "to activate" the option or the field.

Button of

option

(radio)

The button of option (formerly called radio button) can be used

with a field of type Yes/No. It's necessary "to darken" the button

to activate it or to say the equivalent of Yes.

Button hook
The button hook can be used with a field of type Yes/No. It's

necessary to makee "X" in the box to activate it or say the

equivalent of Yes.

Zone of modifiable list

As a group of options and a zone of list, a zone of modifiable list allows you to
select a value among a predetermined list. It's also possible to you to add the
other values to the so necessary list. It's an element that group of options and
the zone of list does not allow you. A list has also the advantage to avoid errors
of spelling during the retranscription of the data. The last advantage of a
modifiable list is that it's possible to show several fields at the same time. This
has the advantage to give a better reference at the time of choosing for a value
of the list.

The exercise consists in creating a zone of modifiable list for the field office that
represents the office location of the employees. The source of the modifiable list
will be the table office that contains the name of cities as well as the addresses
of each of the offices(desks) of the company.

From the form, select the field office and erase it.

From the toolbar, press the button .
Place the zone of modifiable list by clicking in the place where the field office

was located.
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The assistant offers you three ways to determine the source for the modifiable
list. Among choices to determine the source, you can choose the contents of a
table or a query. You can also write the values of your choice. These will be then
kept in a new table. The last possibility allows you to go to a record according to
the choice of this modifiable list.

For this exercise, select the first option: I want that the modifiable list looks
for...

Press the Next button.

The assistant will ask you for the name of the table or the query that will be used
for the source of the modifiable zone. It shows you even the list of these.
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For this exercise, select the table office.
Press the Next button.

The following window asks you to choose from the list of the fields of the query
those that you want to show in the screen. These give you a supplementary
reference during the selection of the value of the modifiable list. Fields will be
shown according to the order that they you will find in the box " selected Fields ".

For this exercise, select in the order the following fields: Offices(desks),
Address, Telephone.

Press the Next button.

The next window asks you to determine the width of each of the columns of the
fields that you selected in the previous window. It's this width that will be used
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when it will be the time to show the modifiable list. So, this window allows you to
show or to hide the key column; the first selected in the previous window. For
this case, it's about the field Offices(desks).

For this exercise, deactivate the option hidden key Column.

To adjust the width of columns:

It's intéssant to be capable of adjusting the width of columns containing of the
data. You can make sure that all the data of the field appears in the box.

Place the cursor at the end of the column or between two columns.
Press and hold the left mouse button and move this one towards the left or to

the right to reduce or widen the column.

For this exercise, adjust the width of columns to show all the contents of these.
Press the Next button.

If there are only two fields in the list of the available fields:

Press the Previous button.
deactivate the option of hidden key column.
Press e Next button.

Because you chose several fields in the posting, the assistant would like to know
the value of that field he should save in the modifiable zone.

For this exercise, select the field Offices(desks).
Press the Next button.
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The assistant asks you then for the place where you want to save the datum. You
can save it in an independent field (Remember the value for later use) or put it in
one of the fields of the table.

For this exercise, store the date in the field office.
Press the Next button.

The last question is to know that is the text of the label that will describe the
modifiable list.

For this exercise, write "Office("desk") in the box.
Press the Finish button.

Here is a preview of the modifiable list ended time.
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Zone of list

A zone of list offers to the user of the form a choice of certain values for a field.
The exercise that follows consists in creating a zone of list and to show a list for
the possible activities(occupations) in the company.

Press the button Bums around of list .

In this database, there is a table that contains the list of the
activities(occupations) of the company. This table is called moreover
Activities(occupations). You can also create your own list by selecting the option "
I would type the wished values. "

For this exercise, select the first option: I want that the zone of list looks for
the values in a table or the query.

Press the Next button.
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Access will ask you for the name of the table or the query that contains the field
with the data to be put in the zone of list. Of the list of tables and queries of the
database, select the one that contains the data that you want to show in the zone
of list.

For this exercise, select the table Activities(occupations).
Press the Next button.

The table contains that a single field: Activity(occupation). In this table, there is
at present that two possible activities(occupations): manager and salesman. If
you wanted to add another Poste to the list, it would be necessary to add a record
to this table. Contrary to a zone of modifiable list, it's impossible to add a record
directly in the zone of list.
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There is also another table that would have been able to be chosen. It's the table
Employees. There is in this one the field posts that already contains a list of the
activities(occupations) of the employees. But, in most of the cases, you'll want to
use the data resulting from another table.

Select the field occupation.

Press the button to transfer the field Activity(occupation) in the zone of the
selected Fields.

Press the Next button.

The assistant of the zone of list asks you then to determine the length the field
that will be shown in the screen.

Place the cursor on the right border of the box.
Press and hold the left mouse button and move the mouse towards the left or

the right-hand side as you want to reduce or to enlarge the width the length the
window.

Once you determined the wanted width, release the mouse button.
Press the Next button.
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The front last stage consists in indicating to the assistant of the zone of list if you
want to save choices in a value for later custom(usage) or among one of the
fields that meets itself in the form. For the exercise, the value chosen by the zone
of list will go to the field Poste.

Select the second option: Store the value in this field.
From the list of the available fields, select the field Poste.
Press the Next button.

The last stage consists in writing the text that will go with the zone of list.

Write in the box of the label: "Post("post office").
Press the Finish button.
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Command button

Command buttons are very practical for the users of forms. They allow easily to
reach options that affect the form or the database. For example, graces(favours)
in the buttons of command, it's possible to cross(spend) from a record to
another, to open or to print a form or a report as well as several other
possibilities. Access offers a series of options predetermined to facilitate the
creation of buttons of command. If, these don't answer your needs, you can
always create a macro or a module and " to attach it " to a button.

The next exercise consists in the creation of a button instructions to pass in the
following record.

From the toolbar, click the command button .

The assistant for the command button will show the following window.

This first window asks for action button you wish for. The first column is the
categories of possible actions. The second column shows the possible actions. For
the exercise, the button should show the following record:

From the column Categories, select the option Movements among enreg.
From the column Actions, select the option following Record.
Press the Next button.
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The next window asks you for that kind of presentation, want on the button. Is it
of the text of your choice or a representative image? If you want of the text, it's
enough to write the text in the first box and to choose the option Text. For the
exercise, an image will be used.

Click on the option Embellishes with images.
From the list of the possible images, select the Next image.

There are also two other interesting options on this window. By clicking the option
" Show all the images ", you'll have more possibilities to choose an image. Even
with this list, it's still possible that there is no image that answers your needs. It's
so possible, with the button To cross(go through) to fetch an image that you
found moreover and to paste it on the button.

Press the Next button.
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The last window asks you for that name, want to give to the control command
button.

In the box, write the text " following Button ".
Press the Finish button.

Image

It's also possible to insert images into a form. That it's the logo of the company or
a representative image.

From the toolbar, click the button of image .

A cursor with the following format will appear. It's enough to place it on the
form in the place where you want to insert the image.

Place the cursor on the form and click the mouse button.

Access will ask you for the endoit and for the name of the image that you want to
insert.

Select the place and the image of your choice.
Press the OK button.

The image will fit on the form. You can always move it on the form. According to
the size(format) of the image, it's possible that you can not change the size. It's
a thing to consider when you create the images for your forms or your reports.
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Frame of independent object

Allows to insert objects resulting from the other Windows applications such as a
chart of Excel or an organization chart of Visio or the other applications. The
object is indépendnant of the contents of Access's tables.

Frame of dependent object

The inserted object is dependent on the contents of tales or Acceess's queries. A
modification of these could affect the dependent object.

Page break

Even in a form, it's possible to put page breaks. It has no effect in the view in the
screen. But, this option is very practical at the time of the printing of the form. It
allows to print a form on several pages.

From the toolbar, press page break button .
Move the cursor at the footer of the Details zone.
Press the left mouse button.

A small control will seem stuck on the left border of the window. This is the
separator of page. All that is above this control will be on a page. The rest will be
printed on another page.

To see the effect of this control, it's first necessary to move it in the middle of the
form.

Click on the control of the separator of page.
Press and hold the left mouse button and move the control in the middle of the

form.

The separator is automatically going to paste to the left border of the form.

Press the button .

You will see a preview of your form if it was printed on paper. You see only also a
part of your form. The rest is on the following page.

Press the button located in the left lower corner of the screen.

The following page will appear to the screen. You go to notice that the rest of the
form will appear on the paper. But, also, you go to see the beginning of a form
for the following record. It's for that reason, for be

Care of printing that page breaks are put in it any end of the zone Detail of the
form; to have two forms on the same paper.
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Control Tab

The control Tab offers two advantages. It groups together(includes) the data in
the same place and sets less(fewer) of space in the screen. It's enough to click
the tab to see the data of the chosen category.

Sub form / Sub Report

Very practical to make complex forms the data of that result from several
connected tables. It's however necessary to pay attention that there are "formal"
relations between tables.

Line

Serves for separating the various sections of a form. Helps at a better reading
and understanding of the form.

Box

Allows to frame of the text or one or several fields. Only for needs of
presentation.

The other controls

There are several other controls that are available.

Press the button.
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You will find a list of all the other objects that you can add. Some you already
know, other that you never imagined existed or accesible.

Change the properties of a field or of an object.

Select the object, or the control, that you want to change an attribute.

Press the button on the toolbar.
OR

Press the right mouse button.
From the context menu, select the Properties option.
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Here is the

list of all

the

properties

or options

that you

can modify

for each of

the

"controls"

of the

form.

The
properties
can be
grouped
together in
4
categories:
Format,
Data,
Évennemen
t and the
Others.

The most
important
option is
the second
of the list:
Source
controls.
Access can
know if the
contents
are a field
of a query
or a table.
It's also
possible to
enter it a
formula.
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Lock a field

Mask a field

Put a page break

Only practical for the printing of the form.

The automatic format

Access allows you to change the presentation of your form by using a
preestablished model.

Press the button.

The following window will appear.

This window allows you to use one of the existing models as well as to decide to
affect these changes to fonts, to colors of the text and the borders.

For this exercise, select the Colour option 2 from all the attributes.
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The assistant of automatic size(format) offers you three options: to create a new
size(format) based on the current values of the Form option of Colour 2 Lists
employees, to update the form with or to delete the Colour model 2.

For this exercise, select the second option (Update Colour 2).
Press the OK button.

Access will take a moment to update the presentation of the form.

The button to generate

Update a Formulas, add functions, a macro or a programming module.

Press the button .

Access the choice offers you to reach the expression generator, the macro
generator or the code generator.

Preview a form

From the creation mode, press the button.
OR

From the Edit menu, select the option Previw a form.
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Tab order

The order of tabulation allows you to determine the order in that the cursor will
pass from a field to another on the form. It's possible to you to change it to allow
you better to meet the needs of the form. For this example, the field Poste
should be below the field Name. Here is how to move it.

From the Edit menu, select theTab Order option.

The screen that is shown gives you the list of the fields that meets itself on the
form in the order that the cursor passes from a field to another.

Click on the small grey box at the left of the field Poste.
Press and hold the left mouse button and move the field below the field Name.

When the field is at the right place, you can release the mouse button.

The Automatic Order button can automatically order the fields. Access orders
fields according to their place on the form: from left to right and top to bottom.
So, the field the closest to the upper left corner of the form will be the first field
where the cursor will stop, that in its right-hand side the second etc.
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But it's can be not what you with need. imagine that you have on your form three
"zones", personal data, salary and social advantages for example. It's very
possible to have these zones the one in quoted(esteemed) by the other one. So,
the automatic order would not be for your advantage. It's for that reason that it's
always possible to change the order of tabulation.

Print a form

Be careful!

Because this is an example, don't print all the records. Print only the first page of
the form. Otherwise, all the records are going to be printed in the form of a form.
You can also change the pagination of the document by using the File menu and
Page setup.

From the File menu, select the Print option.
OR

Press the button.
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Access - Chart forms

Before we begin
Introduction
Create a form form chart with the assistant
Changing a form

Before we begin

Access offers you several types of forms. This Web page demonstrates how to create
you and to use a chart form. For more data about forms generally, watch to go to

the page on forms.

To realize this Web page, it's better use the data of the database demoacc2.mdb or
demoa2k2.mdb (for Access97 or Access 2000 respectively). You can take these

databases from the page of the demonstration files of this site.

Introduction

Access allows you to generate charts from the mass of data that is accumulated. This
page demonstrates how to generate you a chart form and to modify it. The exercise
of this page will demonstrate the sum the commissions of the company by office
location. These data you will find Commission and office of the Employees table.

Why a chart?

To simplify the analysis of a mass of data.
To analyse quickly the trends of the series of data.
To be able to compare the data.
To analyse proportions.

Creating a chart form with the assistant

From the main menu, select the tab Forms .
Press the New button.
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From the list of the available options, select the option Attending chart.

The "source" of a form or a report can be a table or a query. The query to use
records that answer the wanted criteria or resulting from several connected tables.
It's a point to consider during the creation of a chart.

For this exercise, select the Employees table.
Press the OK button.

From the list of the available fields, select fields office and Commission.
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It's enough of:

Choose the field of the left column and to press the button .
OR

Make(do) a double-click on the wished field.

When the wanted fields were selected, press the Next button.

Access a list of types of chart offers you to represent your data.

For this exercise, select the type of chart sector.
Press the Next button.
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Double-click on the button SommeDecommission.

The chart form allows you to generate a synthesis on several elements of the data.
Here is a short description of each of the possible options.

Nobody Show the values of the selected field.

Sum Show the sum a selected field.

Average Show the average of a selected field.

Min Show the smallest value of a selected field.
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Max Show the biggest value of a selected field.

Count Show the number of records of a selected field.

Assure that the synthesis is on the option the Somme.
Press the OK button.

It's always possible to you to change fields or synthesis by returning to the creation
mode.

For this exercise, press the Next button.

It remains still to give a name to the chart as well as to see some other possibilities.

For the name of the chart, enter the name: Total of the commissions of the
company.

Press the Finish button.

Access will take a moment to generate the chart according to the options that you
chose.
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Here is the chart generated from the data of the Employees table.

Modification of the form

To be able to modify the chart form, it's necessary to enter creation mode.

Press the button.
OR

From the Edit menu, select the Creation mode option.

You can change the dimension of the form to answer your needs.

To modify the presentation.

Place the cursor over the chart.
Double-click on the chart.

Access uses the generator of chart of Windows to represent the data. watch to read

the page on the insertion of a chart to learn how to modify it.

Note:
You can not modify the data from the table of data of the chart module.
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Access - Reports

Before we begin
Introduction
Types of reports
Creating a simple report with the assistant
Change a report
Creating a group

Before we begin

To realize the exercises of this Web page, you need the Employees table. You will

find it in the database demoacc1.mdb or demoacc2.mdb on the demonstration
files Web page. For those that use Access on 2000, you'll find on this same page,
files demoa2k1.mdb or demoa2k2.mdb.

Introduction

A report is a representation of the records of the database that is make paper. It's
possible to analyse a synthesis from these data that would be more difficult to have
otherwise. Besides, it's easier to sort out and to group together the data about
relevant fields.

Types of reports

Access can help you during the creation of reports.

Standard: View the records of the database in the form of report.

Graph: To represent diagrammatically the records of the database. An example

of a chart form is demonstrated on this site.

Labels: To prepare labels for the mailing or conference. An example of a report

labels is demonstrated on this site. It's moreover the following page of

this section of the site.

Creating a simple report with the assistant

The example that follows is to demonstrate how to create you a report by using an
assistant by looking at each of the stages of the creation of the report. One looks
also at the possibilities, in each of these stages.

Click on the reports tab .
Press the New button.
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Access offers you several ways to create a new report. You can use the Mode
creation to begin from zero a report. You can also use the assistants to create
reports by answering some appropriate questions. The immediate reports, that show
all the fields of a table or a query under the format of columns (a field below the
other one) or of table (a field next to another), don't ask questions. They generate a
report that shows all the fields of the table in the order that appears in the structure
of the table or the query. The chart assistant allows to generate a chart from the
fields of numeric or monetary type. And to end, the assistant labels you help to
generate a report consisted of label for various situations: of labels of letters in
labels for presentations.

Of the list, select the Report Assistant option.
Among the list of available tables and queries, select the table "Employés"

(employees).
Press the Next button.

The assistant asks you then that are the fields that you need in your report. pay
attention to the order of the fields that you select. It's in this order that they are
going to appear in your new report. It's also possible to select fields of several tables
or queries. It's enough to choose the table or the query from the list. add then one
or several fields of your choice to the list of the selected fields.
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Of the list of the available fields, select, in order, the fields Name, Prénom (first
name), Salaraire (salary), commission, office (office), Poste (occupation) by

clicking the field and by pressing on the button .
Press the Next button.
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The assistant asks you if you want to group together the records on a field in
particular. You can also make " under groups ", or rather groups inside groups.

Of the list of the fields of the report, select the field office.

Press the button .

The outline of the presentation in the right-hand side of the window will change. It's
now going to show fields grouped together with regard to the field office. So, every
time the value of the field office will change, a new group will be generated.

Press the Next button.

The assistant asks you how you want to group together the records. want to group
together in a normal way or only on the first letters contained in the field.

Leave the option to "Normal"
Press the OK button.
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The assistant asks you if you want to sort out the records according to one or several
fields. You can sort out the records until on four fields. The field in the first box has
priority over the second and so on. So, you can choose if you want to show the
records in increasing or lessening order by pressing on the button of highly-rated
right of the name of the field.

Select of the list the field "name" for the first sorting.

The employees will be sorted out according to the name.

Select of the list the field "Prénom (first name)" for the second sorting.

Besides being sorted out on the name, the records will be also sorted out on the
Prénom (first name). So, for the same name, the records will be also sorted out on
the Prénom (first name) of these persons. One of the most advantageous options of
reports is the possibility to generate automatically a synthesis of the results.

Press the button Options of synthesis.

Among the options of synthesis, you can choose from the most frequent
mathematical operations. If need be, you can modify the report to add the other
operations such as the number of records, the standard deviation and so on. This
operation will be demonstrated farther on this page.
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Select the same options as those marked in the previous image.
Press the OK button.
Press the Next button.

The assistant asks you then for that type of presentation what you want for your
report ? You can also decide on the orientation of the paper as well as to force all the
fields on the same sheet.
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Select the same options as on the image above.
Press the Next button.

The assistant asks you a last question on the presentation of the report. This time,
it's about the presentation of the fonts of the report. The assistant offers you several
ways to present the records in the form of text. click the name of each of the styles
to have a preview of the final result.

For the purpose of this exercise, select the "Administrative" type.
Press the Next button.

It remains only to add the main title of the report and to decide if you later want to
have a preview of this one or to modify it at once.
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Write in the box of the title of the report " Liste des employés ".
Press the Finish button.

Here is the first part of the final result.

It's now time to look in detail at the composition of the report.
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Change a report

It's also possible to modify a report better to answer your needs. In time, the report
can need to change better to answer your expectations.

From the outline of the report, press the button creation mode ( ).
From the window Data base, select the report to be modified and press the Modify

button.

The objects of a report

There are several objects, or controls in Access's jargon, that compose a report.
Among some of these, there are "titles", that are of the free text, " zones of text,
that are really fields resulting from tables or from queries, from lines, from boxes,
from calculated fields and several others.

Sections

Besides, these "controls" you will find in various zones.

Headers

Header of This part meets itself at the very beginning of the report. One finds
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the report: there generally the title of the report.

Header of

the page:

This part meets itself at the beginning of each of the pages of the

report. One finds there generally the name of each of the fields that

meets itself in the report.

Header of

the group:

This part meets itself at the beginning of each of the groups of the

report. One finds there generally the description of the group.

Feet

Every heading in its equivalent in the end of the report.

Foot of the

report:

This part contains generally the cumulative or the synthesis of

the report.

Foot of page: This part contains the cumulative of the page as well as the

number of page.

Foot of group: This part contains generally the cumulative or the synthesis of a

group.

Section details

Between the various headings and the feet of zones, there is a section detail. It's in
this zone that will be shown the data of each of the records.

Add a calculated field

As for the queries and the forms, it's possible to add calculated fields that answer
better your needs. For example, there is no standard deviation or the other Formulas
or functions to analyse certain ratios among your data.

The next part consists in adding a calculated field that calculates the total of the
incomes of a group. By income, one implies here the total of salaries and
commissions of the employees.

If you are already not it, put yourselves in creation mode by pressing on the

button.

If the toolbar is not shown, press the button.
Enlarge the footer zone of group office.

From the toolbar, press the button bums around of text .
Click towards your choice in the zone foot of group " office ".
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An independent field and a title are going to appear.

Click in the box of the title and change the text "Incomes".
Click in the zone of text ( independent field).
Write the following formula: =sum( salaire+commission ).

Because there is already a total of salaries and a total of commissions in this zone,
you would have been able to write in the place of the formula = SommeDeSalaire
+ SommeDeCommission.

It's necessary to pay attention not to make errors during the writing of the formula.
Otherwise, at the time of showing the report, Access will ask you of the data about a
field that does not exist. For example, I changed one of the Formulas so that it
calculates the income by using the field commisssion with three " s ". This field does
not exist. But Access will ask you for the value of this field before showing the
report.

An outline of the report ( ) will show you the result. At the end of every group, there
is now a total of incomes.

You can create more elaborated calculated fields by using functions of Access. If you
know the functioning of the function, you can directly write it. Otherwise, you can
use the expression generator to fetch the list of the functions.

Return to creation mode by pressing on the button.
Place the cursor on the calculated field that you have just created.
Press the right mouse button.
Select the Properties option.

OR

Of the standard toolbar, press the button.

Click in the box next to the option Source of control.
Click on the button that has just appeared to the end of the box.

You are now in the expression generators.

Of the first column, double-click on the shirt having one more when it's written
Functions.

The second column included lists it categories of the functions. The third column
included lists it of all the available functions for Access. You can then choose from
the list the function, or the combination of functions, that answers your needs. have
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by fear to experiment. In the worst, the calculation will not work. It will be enough to
re-try until it fonctionne!

The next exercise consists in copying the formula preassignor, =sum(
salaire+commission ), in the footer of the report.

Click on the new formula in the footer of the office group zone.
From the Edit menu, select the Copy option.
Click in the footer zone of the report.
From the Edit menu, select the Paste option.
Move the field next to the existing fields.

Make a preview of the report by pressing on the button .

At the end of the report, there is a new field that shows the cumulative of the
incomes of the employees. Although it's about the same formula, it has no same
area as office formulates it in the zone of group. The first show the result of all the
records whereas the second fact only the cumulative a group at the same moment.

Add a calculated field

It's always possible to add a field that is contained in the table or the query that
created the report. But it's also possible to add calculated fields such as
demonstrated during the creation of a query or a form. As for the form, it's
necessary to put the sign "=" in front of the formula. So, to make the sum incomes,
it's necessary to use the formula =sum([salaire] + [commission]).

It's always possible to improve the presentation of the report but this gives you an
idea in the way that the records will be shown in the report.

It's also possible to copy the formula of incomes and to put it in the other zones. If
you copy the formula and put it in the section Details, the formula will show the
income of each of the records. If you copy the same formula to put it in the foot of
the group office, the result would be the sum incomes by office. The formula of
incomes in the foot of report would show the total sum of the incomes of the
company. The place where is located the formula determines the vast of this one,
that are for a recording, a group or a report.

Creating a group

It's possible any time to modify the order of the sortings of fields as well as the
groups of the report. The next part consists in adding a group to the report as well
as to explain at the same time the difference between a sorting and a group in the
report.

From the Edit menu, select the option sort out and group.
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From this screen, you can determine on that field you want to sort out and to group
together the records of the report. The window shows that the report is at present
grouped together on the field office. So, the records are sorted out on fields Name
and Prénom (first name). The exercise consists in adding a group on the field
Poste. So, besides being grouped together by office location, the records will be
divided by the occupation of the employee. Here are the necessary stages to add the
group Poste.

Place the cursor on the fourth list of fields, just man below the line of the Prénom
(first name) field.

Press the button with the triangle pointing down at the end of the first box of the
line.

Of the list of fields, select the field Poste.
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Among the list of the properties of the field, select the Yes option to show the
header of the group footer.

As soon as you select the one or other one of these two options, the field is used to

group together the records instead of sorting out them only. The symbol appears
in front of the name of the field to indicate that it's about a group on this field. So
two new sections are going to appear in the report, that is the heading of the new
group Poste as well as its foot of page.

If you make a preview of the report, you'll see that the result is not really
interesting. The field Poste fact a group on each of the records instead of group
together them. The reason is that the field posts are in fourth position from the
sortings and the groups. The next stage consists in changing the order of the
sortings and the groups by placing the field Poste in second position.

Click on the grey box to the left of the field Poste.
Press and hold the left mouse button and move the field in second position in the

list of fields.

The outline of the report shows now the data by office location and by occupation of
the employees.
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Remove a group

You saw how adding a regroupement and changing the order of the sortings. The
next exercise consists of removing a group.

Click on the grey box to the left of the field Poste.
Press the Delete key.
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Access - Label Report

Before we begin
Introduction
Modify report

Before we begin

Access offers you several types of reports. This Web page how demonstrates to
create a report labels and to modify it. For more data about reports, watch to go to

the Web page on reports.

The exercise of this page consists in creating a report labels that contains the list of
the mail labels of the list of the customers of the company. This is to demonstrate
that it's possible to have on a label of the text and the fields at the same time. To
realize the exercise of this page, you need the database demoacc2.mdb or
demoa2k2.mbd for Access on 2000. You will find this document on the

demonstration files Web page.

Introduction

Access allows you to create quickly and easily labels from the data of your tables and
your queries. The next part consists in creating a new report from the data of the
Customers table.

From the main menu, click on the reports tab .
Press the New button.

From the list of reports that you can create, select the Label Assistant.
From the list des tables and queries disponibles, select the Clients (customer)

table.
Press the OK button.
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Note:
If you have data that result from several tables, create a query consisted of several

tables. For more data, read Web pages on the queries and the exercises of the
queries.

The assistant labels will ask you some questions on the type of labels on that the
report will print the chosen data. For the exercise, the chosen labels will be that of 2
" (inches) by 4 " (inches) from the Avery company.

For the mesuring unit option, select the English option.
For the type of label, select the Sheet by sheet option.
For the list on possible label at the top of the window, select Avery USA 5163.
Press the Next button.

The option Counts frontally indicates the number of labels that are the one next to
another. It's always possible that you don't find the size(format) that you wish from
the units of measure, the companies and the types of labels. You can so press the
button To personalize to generate your own sizes(formats) of labels with the data
that you possess.

Note:
On Access 2000 offers to choose you among several companies as the choice of
labels. select the company of that you bought labels and model.
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The assistant labels you demand then the kind of presentation of text that you want.
pay attention not to choose a size of too big font. Otherwise, the text will not enter
on the label.

Select the font type, size, style and the color of your choice.
Press the Next button.
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The label assistant asks for the kind of presentation of text that you want. Pay
attention not to choose a font size that's too big. Otherwise, the text will not enter
on the label.

There are two ways to select a field.You can:

Select a field from the left column and press the button .
OR

Double-clic on the disired field from the left column.

For this exercise, place the fields in the same order as described below:

Select the Nom (name) field.
Press the spacebar, the " - " key and the spacebar once again.
select the the field Personne contact (person in charge).
Press the Enter key.

The label will pass to the next line every time you press the Enter key. As you have
just carried out, it's possible to have several fields on the same line. Furthermore,
it's possible to have also of the text and the fields on the same line.

Select the field Adresse (Address).
Press the Enter key.
Select the field Ville (city).
Write the following text ", Qc" (Québec).
Press the Enter key.

We presume in this case that all the clients are in the province of Québec. Another
field (province) will be required if they are spread outside the province. Another field
(country) will be required for international business.

Select the the field Code postal.
Press the Enter key.

The required fields and the presentation are all placed correctly on the label. verify
with the image for this part of the exercise above.

Press the Next button.
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The assistant asks you then if you want to sort out the records on one or several
fields. For the purpose of the exercise, the records will be sorted out in order
crossing according to the name of the company.

From the list fields available form the left column, select the Nom field.

Press the button .
OR

Double-clic on the field Nom.

Press the Next button.
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The assistant will ask you that name it's necessary to give to the report. It suggests
you the title Labels customers. It's a rather good description of the report. So, we
are going to save the label report.

For this exercise, leave the options "as is".
Press the Finish button.

Access will take a moment to generate the report according to the options that you
chose and to save it in your database. Here is what should look like the first label of
the report.

Modify report

From the View menu, select the Creation Mode option.
OR

Press the button.

Access uses the function SupprEspace() to remove spaces useless to the end of a
field. The software uses also the command & to glue together parts of text, placed
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between quotation marks, or the other fields. look at the first line of the label. The
function pastes together the field Nom, the text that was the field Personne
contact put between quotation marks, "-".
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Access - Macro commands

Introduction
Create a macro
Attach a macro to a botton
The Autoexec macro

Introduction

A macro allows to execute a series of instructions one after the other. Besides, you
can "attach" a macro to a button on a form. The exercise that follows consists in
creating a macro girl who contains a single instruction. Later, this macro short
story(piece of news) will be attached to a button of a form.

Create a macro

From the main menu, select the macro tab .
Press the New button.

The window of creation of macro will appear.

Under the column Action is the list of the instructions that you can execute.
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As you see it, Access offers you several instructions.

To have more data about these

From the main menu, select the menu of help by selecting?.
From the menu, select the Summary option and index.
Click on the tab Look for.

It's possible that it's a question the first time that the help is
used inside Access.

If it's not already made, to prepare the file of help by using
the option Maximize research capacities.

Press the Next button.
Press the button Finish.

Access will take a moment to generate the file of help.
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Enter the word "Action" the first box.
Click on the first word action of the list of the second box.

The contents of the third box are going to change to show the
columns in the word "action" contents in the file of help. This
list includes also the actions of the macro.

In the third box, select the action of your choice and press the

button Show at the foot of the window.

To continue the creation of the macro, it's necessary to enter the " arguments of the
action " or the characteristics of this one. These arguments change according to the
type of action. For the action BoîteMsg (message box):

Enter the text following in the box message: " This is a test ".
Select the Yes for the Bip option.
For the type of window, select the Information type.
For the title of the window, write the text "Test".

If you want to add another action, place the cursor below the last action and select it
from the list of the actions.

To protect the macro:
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From the File menu, select the option, Save as / export.
Or

Press the button.

For this exercise, enter the name "Test"
Press the OK button.

Attach a macro to a button of form

The next part consists in attaching(fastening) the short story(piece of news) macro
Test that has just been created in the previous part in a button of form. There are
two ways to paste: paste to a new button or to an already existing button. This part
will cover these two ways.

Paste to a new button.

Return to the main menu and click the Forms tab .
If you already have a form, select it and press the Modify button.
Otherwise, Press the New button. To accelerate the creation of a form, select one

InstantForm:Columns and the table of the employees.
When the form is generated, enter the creation mode by pressing on the

button.

From the toolbar, select the command button .
Click on the form on the place where you want the command button to appear.

The assistant of command button offers several options. It contains several models
of buttons to create quickly buttons the most used in various categories.
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Among the list of the categories, select the category "Miscellaneous".
Select the option " Execute a macro " from the list of the actions.
Press the Next button.

Among the list of the macro available, select macro "Test".
Press the Next button.
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Access the choice offers you to show of the text or an image on the top of the
button. For this exercise, the text "Test" will be written on the button.

Click on the option Text:.
Write the text "Test" in the box in the right-hand side of the option Text:.
Press the Next button.

It remains only to give a name to the button.

For the exercise, write " Test of macro " in the first box of the window.
Press the Finish button.
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Attach an existing button

He can arrive that you change opinion and want to change macro or of option for an
event or a button. This part of the page shows how to change you macro and the list
of the possible events with Access.

Select the creation mode for the form.
Place the cursor over the button to be modified.
Press the right mouse button.
From the list of the possible options, select the Properties option.

Click on the Event tab.

Access a possible list of the events shows you. You can attach a macro or a module
to each of these events. It's so possible that Access executes a macro when you click
a button or a field and a different event if you make a double-click on the same
control.

Click in the box in the right-hand side of the event " On click ".
Press the button with a triangle pointing down at the end of the box.
From the list of the macro and the modules, select macro Test.

Close the window of the properties by pressing on the button.

When you go to press the button Test, one of both following windows will appear as
the assistant of Access is shown in the screen or not.
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The autoexec macro

Access offers you the opportunity to execute a macro-command at the opening of a
database. This gives you the advantage to open with a macro to execute
instructions. For example, you can open the database with a main menu form. You
simply have to create a macro and giving it the Autoexec name. If you want to open
a database without executing the autoexec macro at the opening, keep a finger on
the Shift key at the time of opening the database.
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Access - Relations

Introduction
Types of relations or the cardinality
What's required to make a relation
Create a relation on a query
Create a permanente relation between tables
What to check when Access refuses to create a relation

Before starting

This page includes exercises to experiment with the relations between tables. To help
you in the understanding, you can copy the file demoacc2.mdb for those that have
Access 97 or demoa2k2.mdb for those that have Access on 2000 of the page of

the demonstration files. Click here to return you to this page. Copy the data base
suited on a floppy disk or on your hard drive and return then to this page.

Introduction

The practical aspect to connect tables on fields in common is to avoid the
redundancy. It is useless to rewrite several times the same information. For
example, with a relational data base such as Access, it is useless to write several
times the same information about a customer to every invoice. The force of the
connected tables is to give you access to the information of another table than you
would have no access without a relation between tables.

Let's take the example of tables Charges and Customers. The table Charges
customer's number and no other information about the customer contains the
field. But this field is the key to connect both tables. It is possible to connect it with
the field customer's number of the table Customers. Once connected, it is then
possible to have the other information about the customer such as the name of the
company, its address, it's persons contacts, its margin of credit etc.

The types of relations or the cardinalité

There are three types of relations: one to one, one to many and many to many.
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It is not always easy to determine that kind of relation, so called cardinalité, that
there is between two tables. It is necessary of the practice. I found a small trick to
determine that kind of relation that there is between two tables. I found it
accidentally by giving my demonstrations. I don't know how effective it is. But, it
works very well during the demonstrations. It is a question of putting two questions.

1-For 1 (record of the first table), how many are there in the second table?
2-For 1 (record of the second table), how many are there in the first table?

Both questions always begin by: " For 1 of this, how much it? " The only acceptable
answers are one or many. When you have the answers, place them in the small
image that follows. It is necessary to invert the second question to enter it the
image. Replace the "?" with the results (one or many).

Determine the type of relation

Table 1 Table 2

Q1: 1 - > ?

Q2: ? <- 1

Max:

Then, you write on the last line the biggest, among one and many, of the second and
the last column. You can then know about that kind of relation that it is a question.

The next exercise consists in experimenting with this small trick. It is necessary to
determine that kind of relation that he can there have between tables Invoice and
Customers. It is necessary to ask the questions.

Q1: For 1 invoice, how much have I of customers? The answer is one. An invoice, a
customer.
Q2: For 1 customer, how much may I have of invoice? The answer is many. At least,
you hope for it. It's not practical to have a customer who only comes once! Enter the
information as the image below.

Determine the type of relation

Invoice Customers

Q1: 1 - > 1

Q2: Some <- 1

Max: Some 1



Dr. RACHINI Ali – MS-Access – Relations

173 | 1 9 5

Effectively, it is indeed a relation of one to many of the Customers towards Invoice.
You can now try with the other tables or the other situations.

This means as well as you can find only once the information in common in one of
the tables and several times in the other one. For this example, every customer's
number in the Customers's table is unique. There are two records (or customers)
with the customer's same number. However, in the table Invoices, you can find the
same number of invoice for several different records. It is for that reason that the
relation is called 1 to many. The information in common meets itself only once in the
first table (Customers) and potentially several times in the second (Invoices).

ONE TO ONE RELATION

Ex: A man is married to a single woman. A woman is married to a single man.
I should remind you that the bigamy is illegal!

ONE TO MANY RELATION

Ex: A person can possess several motorcycles. A motorcycle can be possessed only
by a single person. (Let's forget about co-ownership casses for now).

MANY TO MANY RELATION

Ex:. A student follows several classes. A class is followed by several students
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It is necessary to pay attention during the conception of a database with relations of
type " many to many ". There are more details farther of this Web page on this
special case.

What is required to make a relation

2 tables (or queries or a combination of both)
1 field in common in each of the tables.
The same type of field (Text with text, numeric with numeric...)
The same length (no field long 15 characters with one the other long 50

characters!)
The same kind of information (Ex: Code of inventory with codes of inventories, NAS

with NAS...)

Do not try to create a relation between the fields Date and Phone number. Both
fields are not the same types (Text, Numeric, Date/Time, Yes/No, NuméroAuto...)
Also, don't try between fields name and Prénom (first name). Although both fields
are the type "text", they have no same kind of information.

There is however an exception that confirms the ruler. It is possible to make(do) a
relation between a field of type NuméroAuto and a field of numeric type the size of
the field of that is " Whole length ". It would be impossible to create a relation of
type " one to many " if fields in common are of type NuméroAuto. By definition, this
type of field can not have twice the same information!

This exception is of size and very advantageous. For example, the user does not
need to worry to give numbers of identifications to a new customer. Access take care
of it automatically.

Create a relation on a query

It is very advantageous by moments to be capable of showing the information
contained by several tables at the same time. It is however necessary to have a
relation between tables to have an interesting result. The next exercise consists in
creating a relation between two tables in a query.

From the main menu, press the the queries tab.
Press the New button.
Of the list of the available tables, add tables Invoice and Customers.
Select the following fields of the table Charges: Number of invoice and Codes

customer.
Select the following fields of the table Customers: Name and Address.
Execute the query.

What you see is the result of all the possible combinations between both tables.
notice that for every number of invoice there are 5 customers! In fact, there are 14
records in the table Charges and 5 records in the table Customers. So, there is 14
* 5 ( 70 ) records of activated. This is really impossible. The reason is that there is
no relation between these two tables at the moment. If you don't make relations
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between the tables of a query, Access will show all the combinations of possible
records between both tables. It is necessary to create a relation between two tables
to avoid this kind of situation.

To turn(return) to the mode creation:

Press the button.
OR

Of the View menu, select the option Creation.

determine fields in common between both tables.

In that case, it is about fields Customer's number Codes customer and. Although
they have no same name, they are the same types of fields. They have also the
same size(format) or of length and contain the same kind of information.

Place the pointer over one of the fields in common.
By keeping your finger on the left mouse button, move the pointer over the other

field in common.
Release the mouse button..

A thin line should appear between both fields. Both tables are now connected.
Otherwise, re-try.

It is also possible, accidentally , to have connected the fields that have no same kind
of information. It is necessary to remove the bad relation before being able to retry.

Click the line that connects both tables.
Of the Edit menu, select the Delete option.

OR
Press the Delete key of the keyboard.

When tables are correctly connected, it's time to show the result.

Execute once again the query by pressing on the button .

The number of records should have reduced to 14 invoices. It is necessary to notice
that you see the information of two tables at the same time! It is there one of the
big advantages of the relational data bases; be capable of reaching the information
that no table, taken only, is capable of supplying. It is only once that these tables
are connected that they are really effective.
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The mechanism of a relation

From a query, it is possible to modify or to add records. As you write a value in one
of the fields in common. Access will try to find if this value exists in one of the
records of the other connected table. If it finds, you will have access to the contents
of all the fields of the recording. Let's take the example of tables Charges and
Customers that are connected on fields in common customer in a query Codes
customer and No.. If you write a number between 1 and 5, Access can find a
recording in the table Customers and show you all the information of the recording
if you want it.

It is possible to enter or to modify of the information from a query that contains
several tables. It is necessary to make sure that one of the fields in common of all
the connected tables is used in the query. Otherwise, Access will warn you that he
can not realize the query.

Be careful!
Furthermore, this field in common should be the one that you can enter several
times the same information. For example, if you make a relation between tables
Invoice and Customers on the field in common customer's number, use the field
Codes customer of the table Charges because you can enter several times
customer's same number invoices. When you entered the information the table
Customers, you can not bring in it second time!

Creating a permanent relations between tables

It is advantageous to connect tables in the query to reach the information that none
of the only taken tables possesses. The problem with this technique is that it is
necessary to redo the relations every time you make(do) a new query. Access offers
you a way of creating "more permanent" relations between the tables of your data
base. It has also the advantage to verify " the integrity " of the relations between
tables.

From the main menu, it is possible to reach the relations section.

Press the button.
OR

Of the Tools menu, select the option Relation.

It is in this window that you go to create the relations between tables. When you
open this section for the first time, there are no tables; only a big vacuum. It is first
necessary to add tables or queries on that you want to connect. To accelerate the
demonstration, I have already put for you all the tables that will be necessary for the
relations except the table Customers.
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Add a table

When to go to open to you the zone of the relations for the first time, it should be
empty. It is necessary that to add you tables or queries that you want to connect
before establishing the relations.

Of the Relations menu, select the option View the table.
OR

Press the button .
OR

Place the pointer of the mouse in the zone of the relations.
Press the right mouse button.

Of the context menu, select the option View the table.

The following window will appear.
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With Access, it is possible to connect tables or queries if they have a field in
common.

Select the Tables tab.

Then, select the tables of that you want to connect. For the demonstration,

select the table Customers and press the button Add.
Because there are no more other tables to be added, press the button Close.

Establish the relations between tables.

Place the pointer over the field Customer's number of the table Customers.
Click on the left mouse button to select the field.
While pressing the left mouse button, move the pointer over the field Codes

customer.
Release the mouse button.

When you will have made the relation, the following screen will appear.
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Apply the repository integrity

This option is necessary to establish a relation that I call "strong". It is the relation
that makes sure that there is a value in the other connected table. By activating the
option " to apply the repository integrity ", Access makes sure that certain integrity
rules of a relation are respected. It is so that the relations between the connected
tables are always good. No information can be "lost" by letting Access the right
validate these rules.

Access can refuse to create a relation with integrity repository for these
reasons:

The table that contains the unique recording has no option of index without
doubloons or primary key.

The table that contains the unique recording has a double. Ex: several products
have the same product number.

The one of records of one of tables connected with one of the common fields
empties. It is always necessary that fields in common both tables have of the
information in the other table.

The value written in the table that can contain several times the same value in the
field in common has no equivalent in the other table. Ex: one of the records contains
the number of product number 5 although there are only four products, from 1 to 4 ,
of available.

Another reason is that one of the tables is " opened " or shown. It is necessary to
close any tables, queries, states and forms before creating the relations between
tables. Here is the procedure to be followed to close objects that would have
remained opened.

Close the window of the relations.
From the Window menu, select the object (table, query...) that remained opened.

The option of the opened menu allows you to pass easily from an object to another.
In that case, it is to close all the objects opened except the data base and the screen
of the relations.
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Close the object.
If the other objects are opened, except for the data base and the screen of the

relations, repeat the previous operations to close these objects.

You can then re-try to create relations between tables.

The Updated option cascades to it.

Updates in one or several other tables that are connected. If you change customer's
number, all the records of the other connected tables customer of that the code is
identical are also to be modified. Ex: If you change the value of the field No.
Customer of tables Customers, Access goes changed for all the fields in common
connected tables. In that case, would only be the field Codes Customer of the table
Charges.

The Delete in cascade option.

This option erases the records of the other table that have the same field in common
as the killed(abolished) recording. When should one activate this option? It depends
on the contents of tables. In that case, for fiscal reasons, it would be preferable to
keep the data even if the customer leaves. But for another data base, for bookings
for example, it would be preferable to remove the options at the same time as a
booking.

Here is a chart with a representation of tables and relations from them. A little later,
one will ask you to create all the relations between these tables. For the moment,
read the other possible options on the relations.

Delete a relation.

It is possible to remove one relations on tables. There are many reasons to remove a
relation between tables or queries. The first is that you made an error at the time of
the creation of the relation. You chose accidentally the bad field at the time of the
creation of the relation. Or, after a more detailed analysis, you change the relations
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between tables. So, to allow you to modify the structure of a connected table, he can
be necessary previously to remove a relation. Access goes will say it to you if it is the
case.

Click on the line that connects both tables.
From the Edit menu, select the Delete option.

OR
Press the Delete key.

Modify the options of a relation.

Click on the line that connects both tables.
Double-click on this line.

OR
Of the Relations menu, select the option Modify a relation.

The options of the relation are going then to appear. You can modify them and then
press the button to create to keep these modifications.

It's now time to create the relations between tables. Here is the particular case who
could indeed arrive at you at the time of the creation of relations between the tables
of your data base.

Creating a relation between tables Charges and Employees.

It is first necessary to determine that type of relation that it is a question or its
cardinalité.

1 invoice is generated by a single salesman.
1 salesman can generate several invoices.

It is about a relation of type 1 to many.

It is now necessary to create the relation between tables Employee and Invoice on
their field in common.

Place the pointer over the field Numéro of poste (Employee's ID number) of
the table Employees.

Click on the left mouse button to select the field.
While pressing the left mouse button, move the pointer over the field No.

salesman.
Release the mouse button.

It is now necessary to choose the options.

Activate the option Apply the integrity repository.
Make sure that the relation is 1 to many.
Press the button Create.

The relation will not work!
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What to check when Access refuses to create a relation.

As being mentioned above, the relation between tables Charges and Employees will
not work. The contents of certain recording on the field in common (No. salesman
and number of occupation) don't respect the integrity rules. To warn to you of it,
Access will show you the following message.

Read attentively the message to understand what happens. In that case, it is the
second sentence that explains the situation: " The data of the table " Facture " don't
respect the rules of repository integrity ". And it's true. Both last records of the table
have no valid contents in the field No. Salesman. It is for that reason that Access
refuses to create a permanent relation between these two tables.

For this example, you know the cause of the problem. It is enough to put values
suited for these two records to solve the problem. But what to do when you don't
know the cause of the problem? Access has an indispensable tool to offers to make
sure that you have good relations between your tables and/or queries. It is about the
query of not correspondence. The next part consists in creating a query of not
correspondence that determines the cause of the problem between tables Charges
and Employees.

Close the zone of the relations by selecting of the menu File the option Close.

Click on the the queries tab.
Press the New button.
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From the list of the possible queries, choose Assisting Request of not
correspondence.

Press the OK button.

To determine the records that don't correspond between both tables, it is necessary
first to indicate to Access the name of both tables to connect follow-up of the name
of fields in common of both tables.
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It is necessary to indicate to Access the name of the first banks to connect that
causes a problem of relation.

From the list of tables, select the table Charges.
Press the Next button >.
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It is now necessary to indicate the name of the second table that causes a problem
of relation.

From the list of tables, select the Employees table.
Press the Next button >.
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It is then necessary to show to Access that are fields in common of both tables.

From the table Charges, click the field No. salesman.
From the Employees table, click the field Numéro of poste (Employee's ID

number).

Press the button.
Press the Next button >.
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Access asks you then that are the fields that you want to see in the query. For the
purpose of the example, select all the fields.

Press the button .
Press the Next button >.
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To end, Access asks you for the name to look to the query. For the moment, don't
change the name of the query.

Press the button End.

Access shows the result of the query.

Invoices 21 and 22 have no valid values in the No vendeur (salesman's ID number)
field. The invoice number 21 has an employee number (No vendeur) that's
impossible because there are only 7 employees at present in the company. For
invoice number 22, there is no salesman's number. A relation is impossible if the
contents of a field in common is empty.
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For both invoices, enter salesman's number 7 the field No. salesman.

After this correction, it is now possible to you to create a "permanent" relation
between these two tables.

Close the query.
Return to the section of the relations.
Redo the relation between tables Employees and Invoice on their field in common

(Numéro of poste (Employee's ID number) and No. salesman).

Both tables are now connected on a field in common. You can now create the

relations between the tables of this data base such as in the previous chart.

The relations of many to many

Access offers you a way easy to create relations of type 1 to 1 and 1 to many with
the option rules of integrity. However, the creation of relations of type many to many
require more work. Let's take the example of the creation of a relation between
tables Charges and Produced. Above all, it is necessary to determine of that kind
of relation that it is a question.

1 invoice can contain several products.
1 product can be contained in several invoices.

It is indeed a relation of many to many.

It is impossible to directly make a many to many relation. It is necessary to create
an intermediate table that contains the primary key of both tables. It is then
necessary to create two relations of type 1 to many between tables Charges,
Product and the intermediate table by using the field of the primary key of both
tables.

Ex:

Invoice Relation Transition Fact-Inv Relation Inventory

No. Charge 1 - > many Number of invoice

Number of product Many< - 1 Number of inventory

Bought quantity

don't forget to activate the option rules of integrity and also the option of update in
cascade. Otherwise, the relation of many to many is more difficult. So that a relation
works, it is necessary that there is the same kind of information in both connected
tables. The option " To update in cascade " makes sure that the information meets
itself also in the other table. It is so useless to you to worry to have you the
information in both tables. Access take charge of it for you.
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Go to of the screen of the relations

If you want to keep the relations between tables, you should first protect them
before leaving the mode of relations.

Click on the button with the yellow floppy disk .
From the File menu, select the option Close.

Creating an invoice

It is here that all the relations between tables will be put in advantage.

Creating a query that contains all the connected tables.

Click on the the queries tab.
Press the New button.
Select of the list of tables: Invoice, Transition Fact-Inv, Inventory, Customers

and Employees.
Press the button Close.

Every time to add to you a table in the query, the table adds as well as its relations
with the other tables. Furthermore, it is about relations with the options of repository
integrity. The first relation was a "simple" relation; without the possibility of a
relation with repository integrity.

From the list of the possible fields, select in order the following fields:

Number of invoice (Transition Fact-Inv), Codes customer Facture (Invoice),
No. salesman Facture (Invoice), Number of product (Transition Fact-Inv),
Quantity (Transition Fact-Inv), Unit price (Inventory).

It is the necessary minimum of fields to have a query with relations that work. It is
necessary that one of the fields in a relation is shown. Furthermore, this field should
be the one where you can enter the same information several times. You can add the
other fields to your choice. Because they are connected, all the information is going
automatically to display without having to add anything of the information.

To demonstrate you the advantage to connect tables, the last field to be added is a
calculated field. It's going to take the information of two various tables (Quantity and
Unit price) to find the total of the deal. Because it is possible to find the total from
the information of tables, it is useless to have a "Total" field in one of the tables.

Place the cursor in the box empties in the right-hand side of the field Unit price.
Write the following text: Total: [Quantity] * [Unit price]

As for all the calculated fields, it is necessary to give it a name (Total). It is then
necessary to separate the name of the formula by writing one ":". It remains that to
write the formula. This field will give the total of each of the items of the invoice.
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Data entry for an invoices

Having to complete the previous operations for the creation of relations between the
various tables of the data base, it remains to seen how to enter many invoices and
to explain the working of the chosen options. To enter the data,

Press the button.
OR

From the View menu, select the option Banks of data.
Enter no information the field Number of invoice and press the Enter key.

As soon as the cursor is moved to the following field, a number appeared in the first
field. Why?

It is because of the relation between this field and that of No. Invoice of the table
Charges. Not only is the relation of a " 1 to many " type, but there is also an option
" To update in cascade ". It is this option that forces Access to see the contents of
the field No. Number of invoice charges and to copy it in the field. No need to enter
the information every time to begin you a new invoice.

Enter the information for the other fields your choice.

You see that it is possible to enter of the information several tables at the same
time. So, the advantage of the relations because there are redundancy of
information only for fields in common various tables. It is useless to rewrite the
information about the customer or about the product because Access has access to
this information thanks to the relations between tables.

The next exercise consists in adding a second item to the same invoice.

In the field Number of invoice, enter the same number of invoice of the previous
recording.

Enter the information for the other fields your choice.

And so it is possible to add several items to the same invoice. You can use this
technique for the other tables that have a relation of " 1 to many " type.


